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1 Foreword

This documentation describes the general functions of the Drive Based Center Winder application and guides you step by
step through the setup and project configuration of your drive project in the individual operating modes.

The Drive Based Center Winder application contained in the software provides universal solutions for drive-based motion
control using position, velocity and torque/force control types. The motion commands associated with these control types
are categorized into the following operating modes:

= Command
= Center winder

In center winder operating mode or using the 30: MC_Winder motion command in command operating mode, the Drive
Based Center Winder application enables you to implement various winding applications for the center winder in the
velocity control type, e.g. winding, unwinding or rewinding materials such as plastic, wire, textiles or paper.

Additional functions for monitoring process variables such as positions or velocities offer added convenience in monitoring.

The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient functions for efficient
project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

1 | Foreword
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2 User information

This documentation supports you in the setup and project configuration of your drive system with the Drive Based Center
Winder application in conjunction with Drive Based device control.

Technical knowledge

To be able to commission one or more drive controllers using the Drive Based Center Winder application, possibly in
combination with a controller, you should have basic knowledge of handling 6th generation STOBER drive controllers and of
the DriveControlSuite commissioning software.

Technical requirements

Before you begin operating your drive system, you need to have wired the drive controllers involved and initially check that
they are functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer

As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product

This documentation is binding for:

SC6 or SI6 series drive controllers in conjunction with the DriveControlSuite software (DS6) in V 6.7-A or later and
associated firmware in V 6.7-A or later.

2.3 Directives and standards

Refer to the drive controller documentation for the European directives and standards relevant to the drive controller and
accessories.

2.4 Timeliness

Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.5 Original language

The original language of this documentation is German; all other language versions are derived from the original language.

03/2025 | ID 443440.03
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2.6 Limitation of liability

This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

2.7 Formatting conventions

Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.71 Display of warning messages and information

Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

= if the stated precautionary measures are not taken.

A\ cauTiON!

Caution

This word with a warning triangle indicates that minor personal injury may occur

= if the stated precautionary measures are not taken.

/A WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

2 | User information

A DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

= if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.7.2 Markup of text elements

Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning
Interpolated position mode Optional: File or product name or other name
Detailed information Internal cross-reference
http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu Window names, dialog box names, page names or buttons, combined
Settings proper nouns, functions referenced by the interface
Select Predefined entry

Referencing method A

Save your User-defined entry
<own IP address>

EVENT 52: Displays (status, messages, warnings, faults)
COMMUNICATION

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination
Table > Insert table Navigation to menus/submenus (path specification)
2.7.3 Mathematics and formulas

The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition
X Multiplication
+ Division

| Absolute value

03/2025 | ID 443440.03
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2.8 Trademarks

The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen’, CANopen® and CiA” are registered trademarks of CAN in AUTOMATION e.V.,
CiA® Germany, the international user and manufacturer association.
EnDat’ EnDat’ and the EnDat’ logo are registered trademarks of Dr. Johannes Heidenhain

GmbH, Germany.

EtherCAT', EtherCAT" and TwinCAT are registered trademarks and patented technologies,
Safety over EtherCAT’ licensed by Beckhoff Automation GmbH, Germany.

PLCopen’ PLCopen’ is a registered trademark of the PLCopen Organisation, Netherlands.
PROFIBUS’, PROFIBUS® and PROFINET" are registered trademarks of PROFIBUS

PROFINET’ Nutzerorganisation e.V., Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.




3 | Safety notes STOBER

3 Safety notes

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

= Observe the safety notes in the drive controller documentation.

= Consider the residual risks in the risk assessment for the machine or system.

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

= Observe the security notes in the drive controller documentation.
= Protect the parameterization, e.g. from unauthorized access.

= Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).

10
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4 What you should know before commissioning

The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

4.1 DS6 program interface

Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

11
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Fig. 1: DS6: Program interface

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in

the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter You can use variable parameter lists to compile any parameters in individual parameter
lists lists for a quick overview.
9 Status bar In the status bar, you can find the specifications of the software version and get additional

information about the project file, the devices and the progress of the process during
processes such as loading projects.

12
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411 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

- Reset Resets the view to factory settings.
EEE Project Shows/hides the Project window (project tree, project
menu).
= Messages Shows/hides the Messages window.
V’ Parameter check Shows/hides the Parameter check window.
' Variable parameter lists Shows/hides the Variable parameter lists window.

e

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.

13
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41.2

Navigation using sensitive circuit diagrams

Axis model

LIETypo efasks | D: Liser cafined, ratatiensl |
e

La2% Motor encoder | 2 Xd-encnder =]

Rtmborw, lmitert moersert

Scaling axis

Motor

Fig. 2: DriveControlSuite: Navigation using text links and symbols

A4

In order to graphically illustrate the processing sequence of actual and set values, the use of signals or the arrangement of

drive components and to make configuring the accompanying parameters easier, they are displayed on the respective
wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a

result, allow you to reach additional helpful detail pages with a click.

14
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4.2 Meaning of parameters

You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,

etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a

coordinate or the combination of coordinate and name.

E50 | Drive controller | G6 | VO
| | |

Coordinate Name Version

Drive controller
generation/series

4.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.
A Drive controllers, communication, cycle times
B Motor
C Machine, velocity, torque/force, comparators
D Set value
E Display
F Terminals, analog and digital inputs and outputs, brake
G Technology — Part 1 (application-dependent)
Encoder
| Motion (all motion settings)
J Motion blocks
K Control panel
L Technology — Part 2 (application-dependent)
M Profiles (application-dependent)
N Additional functions (application-dependent; e.g. extended cam control unit)
P Customer-specific parameters (programming)
Q Customer-specific parameters, instance-dependent (programming)
R Production data for the drive controller, motor, brakes, motor adapter, gearbox and geared motor
S Safety (safety technology)
T Scope
V] Protection functions
z Fault counter

Tab. 1: Parameter groups

15
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4.2.2

Parameter types and data types

In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The

data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,

data types and their value range can be found in the following table.

INT8
INT16
INT32

BOOL

BYTE
WORD
DWORD

REAL32
(single type according to
IEE754)

STR8
STR16
STR80

Integer or selection
Integer

Integer or position

Binary number

Binary number
Binary number

Binary number or parameter
address

Floating-point number

Text
Text

Text

1 byte (signed)
2 bytes (1 word, signed)

4 bytes (1 double word,
signed)

1 bit (internal:
LSB in 1 byte)

1 byte (unsigned)
2 bytes (1 word, unsigned)

4 bytes (1 double word,
unsigned)

4 bytes (1 double word,
signed)

8 characters
16 characters

80 characters

Tab. 2: Parameters: Data types, parameter types, possible values

Parameter types: Use

= |nteger, floating-point number

For general computing processes

Example: Set and actual values

= Selection

Numeric value to which a direct meaning is assigned

Example: Sources for signals or set values

= Binary number

Bit-oriented parameter information that is collected in binary

Example: Control and status words

= Position

Integer combined with associated units and decimal places

Example: Actual and set values of positions

= Velocity, acceleration, deceleration, jerk

Floating-point number combined with associated units

Example: Actual and set values for velocity, acceleration, deceleration, jerk

= Parameter address

Referencing of a parameter

Example: In F40 AO1 source, for example, EO8 n-motor filtered can be parameterized

= Text
Outputs or messages

-128 - 127
-32768 — 32767

-2 147 483 648
—2147 483 647

0,1
0-255
0-65535

0-4294967 295

-3.40282 x 10
—3.40282 x 10*

16
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4.2.3 Parameter types

The following types of parameters are differentiated.

Simple parameters  Consist of one group and one line witha  A21 Brake resistor R: Value = 100 ohms
defined value.

Array parameters Consist of a group, a line and multiple A10 Access level
sequential (listed) elements, which have

the same properties but different values. = A10[0] access level: Value = Access level via

operating unit

= A10[2] access level: Value = Access level via
CANopen and EtherCAT

= A10[4] access level: Value = Access level via
PROFINET

Record parameters  Consist of a group, a line and multiple A0O Save values
sequential (listed) elements, which can
have different properties and different
values.

= AO0O0[0] Start: Value = Start action
= AO00[1] Progress: Value = Display action progress
= A00[2] Result: Value = Display action result

Tab. 3: Parameter types

4.2.4 Parameter structure

Every parameter has specific coordinates with the following structure.

1. E250(2] .3
T

Line
Group  Element
Axis Bit
= Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters
(value range: 1—4).

= Group
The thematic group to which a parameter belongs (value range: A —Z).
= Line
Distinguishes the parameters within a parameter group (value range: 0 —999).
= Element (optional)
Elements of an array or record parameter (value range: 0 — 16000).
= Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 — 31).
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4.2.5 Parameter visibility

The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

= Level 0

Elementary parameters

= Level 1l

Important parameters of an application

= Level 2

Important parameters for service with extensive diagnostic options

= level 3

All parameters needed for commissioning and optimizing an application
The parameter A10 Access level controls general access to parameters:
= Qver CANopen or EtherCAT (A10[2])

= Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.
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4.3 Signal sources

Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a fieldbus system and
terminals. You can use the corresponding selection parameters, referred to as signal sources, to configure in
DriveControlSuite whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as the source. In case of
activation by fieldbus, parameters are selected as sources for control signals and set values, which must be part of the
process data mapping between the controller and drive controller so that the controller can write to them via fieldbus.

4.4 Non-volatile memory

All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller
To save the configuration in non-volatile memory on a drive controller, you have the following options:

= Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

= Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > AQO Save values: Set the parameter
A00[0] to the value 1: Active

= Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press and hold the operating button for 3 s

Saving to all drive controllers within a project
To save the configuration in non-volatile memory on several drive controllers, you have the following options:

= Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

= Saving the configuration using the Online functions window:

Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with the last correct configuration that was saved and with fault 40: Invalid data the next time it is
switched on. In order to acknowledge the fault and successfully complete the saving process, the configuration must be
stored again in non-volatile memory and the action must be completed.
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5 Commissioning

The following chapters describe how to commission your drive system using DriveControlSuite.

For the components of your axis model, we require one of the following two combinations as an example:

Synchronous servo motor with EnDat 2.2 digital or EnDat 3 encoder (and optional brake)

These motors are saved along with all relevant data for the project configuration in the DriveControlSuite motor database
and in the electronic nameplate.

Upon selecting the motor from the database, such as when reading out the nameplate, all data is transferred to the
corresponding parameters. There is no need for complex parameterization of the motor, encoder and brake.

LM Lean motor without encoder (with optional brake)

These motors are stored in the motor database of the DriveControlSuite, along with all the data relevant for project
configuration. Furthermore, the motor data and the release and engaging times of the brake are part of the firmware.
Upon selecting the desired motor from the database, all data is transmitted to the corresponding parameters. The release
and engaging times of the brake are also stored. If a brake is present, you must only activate this manually. However,
complex parameterization of the motor and brake is not necessary.

For asynchronous motors, the motor data relevant for project configuration is also taken from the motor database. All
other motor types need to have their parameters configured manually.

Before you begin commissioning, make sure that the system nodes are hooked up and supplied with control voltage.

Information
Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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5.1 Initiating the project

In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

511 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project
1. Start DriveControlSuite.
2. Onthe start screen, click Create new project.

= The new project is created and the configuration dialog for the first drive controller opens.

= The Drive controller button is active.

Projecting the drive controller

1. Properties tab:

Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:

Define the reference code (equipment code) of the drive controller.

1.2. Designation:

Give the drive controller a unique name.

1.3. Version:

Version your project configuration.

1.4. Description:

If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:

Select the series, device type and firmware version of the drive controller.

3. Option modules tab, Safety module:

If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:

Project the basic control of the drive controller.

4.1. Device control:

Select device control Drive Based.

4.2. Rxprocess data, Tx process data:

If you use a fieldbus to control the drive controller, select the corresponding receive and transmit process data.
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Projecting the axis

1. Click Axis A.

2. Properties tab:
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the axis.

2.2. Designation:

Give the axis a unique name.

2.3. Version:

Version your project configuration.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Application tab:

Select the Drive Based Center Winder application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter

the accompanying motor data later.
5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.

512 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (see Further information [P 152]).

513 Creating other drive controllers and modules

In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a new drive controller to
your project, be sure to always assign it to an existing module. Group drive controllers in a module if, for example, they are
located in the same control cabinet or work together to operate the same machine part.

Creating a drive controller
1. Inthe project tree, select your project P1 > module M1 > context menu Create new drive controller.
= The drive controller is created in the project tree and the configuration dialog opens.

2. Project the drive controller as described in Projecting the drive controller and axis [P 21].

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module
1. Inthe project tree, select your project P1 > context menu Create new module.

= The module is created in the project tree.

2. Project the module as described in Projecting the module [» 23].

3. Repeat the steps for all other modules that you want to project.
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514 Projecting the module

Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.
= The configuration dialog for the module opens.
2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the module.

2.2. Designation:

Give the module a unique name.

2.3. Version:

Version the module.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

515 Projecting the project

Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.
= The configuration dialog for the project opens.
2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:

Define the reference code (equipment code) of the project.

2.2. Designation:

Give the project a unique name.

2.3. Version:

Version the project.

2.4. Description:

If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.2 Mapping the mechanical axis model

To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° of real axis movement). The scaling of the axis model is
calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or drift.

5.2.1 Parameterizing the motor

You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and
encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. You only have to parameterize the cable
length in use. Even the brake purging and engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:

Select the cable length of the power cable in use.
4. Repeat the steps for the 2nd axis (only for double-axis controllers).
Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard

area.
2. Select the Brake wizard.

3. FOO Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Motor protection

The drive controller has an i>t model of the motor, a computational model for thermal monitoring of the motor. To activate
it and set up the protective function, configure the following settings (deviating from the presets): U10 = 2: Warning and
U11 =1.00 s. This model can be used instead of or in addition to motor temperature monitoring.
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52.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:
= Define the axis model
= Scale the axis
= Parameterize the position and velocity window
= Limit the axis (optional)
e Limit the position
e Limit the velocity, acceleration and jerk

e Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis

individually.

5.2.2.1 Defining the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Axis model wizard.

3. B26 Motor encoder:

Define the interface to which the motor encoder is connected.

4. 102 Position encoder (optional):

Define the interface to which the position encoder is connected.

Information

For Drive Based Center Winder applications, the axis type and travel range are preset by the application and cannot be
changed subsequently (axis type: 105 = 2: Rotational; travel range: 100 = 1: Endless; revolution length: 101 = 360 °).

Information

If you do not parameterize it differently for 102 Position encoder, B26 Motor encoder is used for position control as

standard.
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5.2.2.2 Scaling the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,

accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. 101 Circular length:
If you have selected 1: Endless = 100 Position range, define the revolution length.

5. 103 Axis polarity:
Use the polarity to define the direction of interpretation between the axis movement and motor movement.

Information

For Drive Based Center Winder applications, the axis type and travel range are preset by the application and cannot be
changed subsequently (axis type: 105 = 2: Rotational; travel range: 100 = 1: Endless; revolution length: 101 = 360 °).

5223 Parameterizing the velocity window
Specify velocity zones for set values by parameterizing a boundary value for reaching a velocity.
1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:

Parameterize a tolerance window for velocity tests.

5224 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gearbox output
and axis in order to convert the values to all other locations in the axis model.
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Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using hardware limit switches.

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
Select the Axis model wizard > Limit: Position.

1101 Source positive /limit switch, 1102 Source negative /limit switch:

To limit the travel range of the axis in the positive or negative direction of motion via hardware limit switches, select

the source of the digital signal that is used to evaluate a limit switch at the positive or negative end of the travel range.

3.1. Ifafieldbus is the source, select 2: Parameter.

3.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration

according to your application. The default values are designed for slow velocities without gearboxes.

1.

2.

10.

Select the Motor wizard.

B83 v-max motor:

Determine the maximum permitted velocity of the motor.
Select the Axis model wizard > Axis: Scaling.

Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the output using the maximum permitted

velocity of the motor.
Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

110 Maximal speed:
Define the maximum permitted velocity for the output.

111 Maximal acceleration:

Define the maximum permitted acceleration for the output.

116 Maximal jerk:
Define the maximum permitted jerk for the output.

117 Quickstop deceleration:
Define the desired quick stop deceleration for the output.

Repeat the steps for axis B (only for double-axis controllers).

Limiting the torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated

operation together with the overload reserves.

1.

2.

Select the Axis model wizard > Limit: Torque/force.

C03 Maximum positive torque/force, CO5 Maximum negative torque/force:

Define the maximum permitted set torque/maximum permitted set force.

C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-

controlled emergency stop SS1, SS1 and SS2.
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53 Referencing absolute position

When commissioning a system with position measurement systems, the relation of a measured to an actual axis position
must be determined to be able to work with absolute positions.

If you are working with absolute positions, reference the axis now. Otherwise, proceed by parameterizing application-
specific conditions and responses of the Drive Based device control.

Information

If you are using a double-axis controller with two projected axes, you must reference the absolute position for each axis
individually.

5.31 Defining the referencing method

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Referencing wizard.

3. 130 Referencing type, 131 Referencing direction, 135 Referencing with zero pulse:
Define the characteristics for referencing.
For information on possible combinations of the named characteristics as well as detailed descriptions of the

individual referencing methods, see Referencing methods [P 112].

4. 143 Move to reference position:

If the axis is to automatically move to the referenced position after referencing, set this parameter to 1: Active.

53.2 Parameterizing the reference switch

If you are working with absolute positions and would like to determine a reference position while referencing using the
reference switch, proceed as follows.

1. Select the Drive Based Center Winder application wizard > Data sources > Application digital signals: Data source.
2. 1103 Source reference switch:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 3 of the control word 1210 of the application is the source, select 2: Parameter.

533 Setting the reference

If you are working with absolute positions and would like to reference without using a referencing run, the value of the
current actual position is applied directly as a parameter value from 134 using the Set reference signal.

1. Select the Drive Based Center Winder application wizard > Data sources > Application digital signals: Data source.
2. 1111 Source set reference:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 11 of the control word 1210 of the Drive Based Center Winder application is the signal source, select

2: Parameter.
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54 Parameterizing Drive Based device control

The Drive Based device control describes the control sequence of a drive controller based on a state machine, i.e. a drive
controller switches its state due to an event. Some of the conditions and responses coupled with the state transitions can
be influenced depending on the application; for example, it is possible to define the end of a quick stop or enable signal
delays tailored to the respective application case.

Detailed information on the device control and Drive Based device state machine can be found in the chapter Drive Based
device control [» 139].

5.4 Parameterizing transition conditions
v" You have projected a drive controller with the Drive Based device control.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based device control wizard.

3. A34 Auto start:
If the drive controller is to switch directly to the Operation enabled state after the Switch on disabled state, activate

this parameter.

4. A43 Enable switch-on/off delay
If you need to hide possible fault or test pulses on the enable signal input, enter the maximum internal activation and

deactivation delay.

5. A44 Quick stop at enable off:

If the drive is to be stopped with a quick stop in the event of a deactivated enable signal, activate this parameter.

6. A60 Source additional enable:

If you are working with multiple enable signals, define the source of additional signals in this parameter.

7. A29 Quick stop in case of fault:
If the drive is to be stopped with a quick stop—if possible—in case of a fault, activate this parameter. If the parameter

is deactivated, motion of the axis is no longer controlled by the drive controller.

8. A39 Maximum quick stop duration for enable off:
If you have selected 1: Active for parameter A44, define the maximum time after which the power unit is switched off
in A39.

9. A45 Quick stop end:
In this parameter, define whether a quick stop is considered ended when the drive is at a standstill or when the quick

stop request is canceled.

10. A62 Source /quick stop:

Define how a quick stop is triggered in this parameter.

11. E48 Device control state:

Shows the current state of the drive controller.

12. If you are using a double-axis controller, click in the project menu > Wizard area on the second projected axis and

repeat the steps.
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55 Transmitting and saving the configuration

In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

/A WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

= Only change the configuration if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:
= Network supports IPv4 limited broadcast

= All drive controllers and the PC are in the same subnet (broadcast domain)

v" The drive controllers are switched on and can be found in the network.

1. Inthe project tree, select the module under which you have recorded your drive controller and click Online

connection in the project menu.

= The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column:

Activate the IP addresses in question and confirm your selection with OK.

= The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection

of transmission type from Read to Send.

4. Change the selection Create new drive controller:

Select the configuration that you would like to transfer to the drive controller.
5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:

Click Establish online connections.

= The configurations are transferred to the drive controllers.
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Saving a configuration

v" You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (AQO0).

= The Save values (A0O0) window opens.
2. Select on which drive controllers you want to save the configuration.

3. Click Start action.
= The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A0O) window.

Information

For the configuration to take effect on the drive controller, a restart may be required in certain cases, such as after the
configuration is saved on the drive controller for the first time or when changes are made to the firmware or process data

mapping.

Restarting a drive controller

v’ You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

= The Restart (A09) window opens.
2. Select which of the connected drive controllers you want to restart.
3. Click Start action.

4. Confirm the safety note with OK.

= The Restart (A09) window closes.
The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

The selected drive controllers restart.
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5.6 Testing the configuration

After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.

5.6.1 Testing jog mode

Jog control panel provides various commands for jog mode which you can use to test the configuration of your projected
axis model for plausibility.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Testing the configuration using the jog control panel
v" There is an online connection between DriveControlSuite and the drive controller.
v’ You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using

the Jog+, Jog-, Jog step+ and Jog step- buttons.
6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog- cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in 114.

Jog+ and Jog- have a higher priority than Jog step+ and Jog step-.
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5.6.2 Testing the motion commands

Control panel motion provides a standard set of motion commands which you can use to test the basic movements of your
axis. The command set is based on the PLCopen standard and supplemented by manufacturer-specific motion commands.

If you are working with absolute position measuring systems and need the MC_MoveAbsolute motion command for

testing, you must reference an absolute position in advance (see Referencing absolute position [P 28]).

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.

/\ WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the motion control panel
v' There is an online connection between DriveControlSuite and the drive controller.
v" You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Control panel motion wizard.

3. Click Control panel on and then Enable.

= The axis is monitored via the active control panel.
4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. K402 Command:

Select the desired command and define the position, velocity, acceleration, deceleration and jerk.
6. Execute the command by clicking Start.

7. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis precisely using the

individual commands.
8. Use your test results to optimize your configuration as necessary.

9. To deactivate the control panel, click on Control panel off.
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5.7 Parameterizing the Drive Based Center Winder application

The Drive Based Center Winder application provides two operating modes: center winder operating mode and command
operating mode.

Center winder operating mode concentrates on the 30: MC_Winder motion command, which is essential for winding.
Command operating mode additionally provides you with a standard set of motion commands based on PLCopen, which is
supplemented by your own motion commands. The operating mode that is best suited to your application depends on your
application case. If you are coordinating motion sequences using a controller and need different motion commands, use the
command operating mode. If you are not using a controller or only need the motion command for winding, select the
center winder operating mode.

The general motion variables are grouped in the mode-independent Data sources wizard. Depending on the operating
mode, unique wizards are also available which you can use to parameterize operating mode-specific motion variables. The
general or operating mode-specific motion variables you need to parameterize depend on your drive project.

If you would like to use set values from external sources for your project, parameterize them in the first step. Then,
continue with the operating mode-specific motion variables in the respective wizards.

Information

A drive controller can only process the motion commands of one operating mode for each projected axis. If you are using a
double-axis controller with two projected axes, you must configure the operating mode for each axis individually.

To configure the Drive Based Center Winder application, follow the handling instructions for the operating mode in which
you want to operate the corresponding axis.

5.71 General motion variables and signal sources

First, parameterize the general motion variables and signal sources before you begin parameterization of the operating
mode-specific motion variables. The motion variables that you need to parameterize depend on your drive project.

Information

If you are using a double-axis controller with two projected axes, you must configure the shared motion variables and signal
sources for each axis individually.
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5711 Velocity — Parameterizing sources

If you are obtaining the set value for velocity from external sources for applications of the Drive Based Center Winder type,

enter this as described below.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by

reading out a parameter (such as with PID controllers).

Set velocity — Parameterizing the source

If you are obtaining the set value for velocity from an external source, enter the source for the main set value.

v’ Use the motion command MC_MoveSpeed or MC_MoveVelocity.

1.

2.

Select the Drive Based Center Winder application wizard > Data sources > External velocity: Data source.
G461 Source external velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G460.

2.2. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G811.

G460 External velocity:
If you have selected 4: Parameter G460 for G461, enter the set velocity here.

G811 Indirect read external velocity:
If you have selected 5: Indirect read parameter G811 for G461, enter the associated parameter coordinate here.

Additional velocity — Parameterizing the source

If you also want to regulate the set velocity, enter the source for the additional set value.

v" Use the motion command MC_MoveSpeed or MC_MoveVelocity.

v" You obtain the set velocity from an external source.

1.

2.

Select the Drive Based Center Winder application wizard > Data sources > External additional velocity: Data source.
G464 Source external additional velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G463.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter G812.

G463 External additional velocity:
If you have selected 4: Parameter G463 for G464, enter the set velocity here.

G812 Indirect read additional external velocity:
If you have selected 5: Indirect read parameter G812 for G463, enter the parameter coordinate here.
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571.2 Velocity override — Parameterizing the source

If you would like to use a velocity override to scale the velocity profile of your motion commands, enter the source for the
velocity override.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

1. Select the Drive Based Center Winder application wizard > Data sources > Velocity override: Data source.
2. G467 Source velocity override:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G466.

2.2. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G813.

3. G466 Velocity override:

If you have selected 4: Parameter G466 for G467, enter the set velocity here.

4. G813 Indirect read velocity override:

If you have selected 5: Indirect read parameter G813 for G467, enter the parameter coordinate here.

5.71.3 Torque/Force - Parameterizing sources

If you have selected the motion command MC_TorqueControl for Drive Based Center Winder type applications and obtain
set values from external sources, enter the sources for the set torque/force and velocity bracketing.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal parameter or indirectly by
reading out a parameter (such as with PID controllers).

Set torque/force — Parameterizing the source

If you obtain the set value for torque/force from an external source, enter the source for the set torque/force.

v’ You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Center Winder application wizard > Data sources > Set torque/force, velocity bracketing: Data

source.
2. G470 Source torque/force reference:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the general data source, select
4: Parameter G469.

2.2. Ifthe set value is read out indirectly via a parameter, select 5: Indirect read parameter G814.

3. G469 Torque/Force reference:
If you have selected 4: Parameter G469 for G470, define the value for set torque/force here. The value relates to

C03 Maximum positive torque/force and C05 Maximum negative torque/force.

4. G814 Indirect read torque/force reference:

If you have selected 5: Indirect read parameter G814 for G470, define the associated parameter coordinate here.

5. G500 Torque/force ramp removal, G501 Torque/force ramp removal:

Define the ramps for the build-up or reduction of torque/force.
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Velocity bracketing — Parameterizing the source

If you obtain values for limiting the velocity from an external source, enter the source for the velocity bracketing.

v’ You are using the 9: MC_TorqueControl motion command.

1.

Select the Drive Based Center Winder application wizard > Data sources > Set torque/force, velocity bracketing: Data

source.
G473 Source velocity bracketing positiv:
2.1. If you are transmitting data via fieldbus, select 4: Parameter G472.

G472 Velocity bracketing positiv:
If you have selected 4: Parameter G472 for G473, define the maximum limit that you want to permit for your

mechanical system.
G476 Source velocity bracketing negative:
4.1. If you are transmitting data via fieldbus, select 4: Parameter G475.

G475 Velocity bracketing negative:
If you have selected 4: Parameter G475 for G476, define the maximum limit that you want to permit for your

mechanical system here.

Information

If you define the velocity bracketing using G472 or G475, you should allow the control enough room. Therefore, select a

value for the velocity bracketing that is greater than 1%. Values less than 1% are internally set to 1% and values greater
than 100% are internally set to 100%. G472 and G475 refer to 110 Maximal speed.

38

03/2025 | ID 443440.03



03/2025 | ID 443440.03

STOBER

5 | Commissioning

optional.

572 Parameterizing center winder operating mode
The following graphic shows the signal flows of center winder operating mode. The elements shown in a lighter shade are
Controller
Motion Alternative
variables sources

Fig.

Controller
Override
Al

3: Center winder operating mode: signal flows

In center winder operating mode, the 30: MC_Winder motion command is permanently stored on the drive controller with

associated set values. This allows you to use set values for the material velocity and material tensile force for various

winding applications, e.g. for winding, unwinding or rewinding materials such as plastic, wire, textiles or paper.

In center winder operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a

fieldbus and terminals.

Proceed as follows ...

Activate center winder operating mode.

Select the desired winding method according to your application.
Parameterize the source of the winding diameter (calculator or sensor).
Compensate for the friction and, optionally, the mass inertia of the axis.

Parameterize the required motion variables (material tensile force, material velocity, dancer position) according to the
winding method.

If necessary, parameterize the PID controller according to the winding method.

As an option, parameterize the material length or material tear monitoring.

You can find more information on the winding methods of the Drive Based Center Winder application under Winding

methods [P 91].

39



5 | Commissioning STOBER

Information

The motion variables available for this operating mode that you configure in the software depend on your application case
as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,

terminals).

5.7.21 Activating center winder operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Center Winder application wizard.

3. Operating modes area:

Activate the option for center winder operating mode.
The associated wizards are available for parameterizing the operating mode.

The 30: MC_Winder motion command is selected in the background.

5722 Selecting the winding method

Select the desired winding method for the center winder according to your application. Depending on the winding method,
it may be necessary to parameterize different motion variables and possibly the PID controller.

You can find more information on the winding methods of the Drive Based Center Winder application under Winding

methods [P 91].

1. Select the Drive Based Center Winder application wizard > Center winder.

2. LOO Center winder method:

Select the desired winding method for the center winder.

2.1. If the material velocity is the focus of the application, select 0: Velocity control (open loop) or 5: Velocity

control.

2.2. If the material tensile force is the focus of the application, select 1: Tensile force control (open loop), 2: Tensile

force control, torque correction or 3: Tensile force control, velocity correction.
2.3. If you are working with a dancer, select 4: Dancer position control, velocity correction.

3. L10 Source center winder polarity:
Select the direction of interpretation between the winding direction and motor movement, i.e. the relationship

between the signs of the set material velocity L420 and set velocity of the motor L102.

3.1. If the signs of the set velocities are the same, select 0: Positive.

3.2. If the signs of the set velocities are inverted, select 1: Negative.

3.3. If the control word of the center winder is the source, select 2: Parameter L150.

3.4. If adigital input (direct or inverted) acts as the source, select the corresponding input.

You can find more information on the winding direction under Winding direction [» 100].
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5723 Parameterizing the diameter source

Parameterize the source of the winding diameter based on whether a sensor serves as the source for the diameter in your
drive project or whether the diameter is calculated by the drive controller. A sensor for the actual material velocity is
required for the calculation of the winding diameter by the drive controller. First configure the general settings as described
below, then parameterize either the diameter sensor or the diameter calculator, depending on the source.

You can find more information on the winding diameter under Winding diameter [» 98].

Parameterizing the diameter

Parameterize the minimum and maximum permitted winding diameters and optionally define the time constant for the
filter of the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

2. LO3 Minimal diameter:

Define the minimum permitted diameter of the winding (usually corresponds to the winder case).

3. LO4 Diameter maximum:

Define the maximum permitted diameter of the winding according to your application.

4. L111 Diameter time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Parameterizing the diameter source
Select either a sensor or the diameter calculator as the source for the winding diameter.
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L20 Source diameter:

Select the source for the winding diameter.
2.1. If the drive controller is to calculate the winding diameter, select 0: Diameter calculator.
2.2. If asensor is the source for the winding diameter, select 1: Diameter sensor.

= The parameters and wizards for parameterization of the winding diameter are displayed according to the selected

source.
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Parameterizing the diameter change limit

As an option, you can limit the change in the winding diameter with regard to the winding direction, maximum permitted
change per second and, if applicable, change based on the axis enable signal.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Limitation: Diameter change.

2. L35 Source diameter change limitation:

Define whether the winding diameter is limited based on the winding direction.
2.1. If the winding diameter may change in both directions, select 0: Inactive.
2.2. If the winding diameter may only change in the winding direction, select 1: Active.

2.3. If the control word of the center winder is used as the source for limiting the diameter change, select
3: Parameter L150.

2.4. |If adigital input (direct or inverted) acts as the source, select the corresponding input.

3. L36 Diameter change maximum:

As an option, you can define the maximum permitted change in the winding diameter per second.

4. L37 Diameter change limit enable dependent:

Select whether the diameter change limit should pause in case of Enable-off (e.g. to replace the winder case).
4.1. To limit the diameter change independently of the enable signal, select 0: Inactive.
4.2. To limit the diameter change depending on the enable signal, select 1: Active.

You can find more information on the winding direction under Winding direction [» 100].

5.7.2.31 Parameterizing the diameter sensor
If a sensor serves as the source for the winding diameter, parameterize a fieldbus as the source.
v" The winding diameter is measured using a sensor (L20 = 1: Diameter sensor).
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L21 Source diameter sensor:

Select the source for the diameter sensor.

2.1. If afieldbus is the source, select 4: Parameter L25.
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57232 Parameterizing the diameter calculator

If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as described below.

Information

The winding diameter is required for a consistent calculation of the material tensile force. When L20 = 0: Diameter
calculator, it is calculated by the drive controller from the actual velocity of the motor and actual material velocity, among
other factors. Accordingly, the winding diameter cannot be calculated when the axis is at a standstill. This means that,
depending on the actual winding diameter, a material tensile force that is temporarily too low can result when continuing
the 30: MC_Winder motion command.

There are 2 options for enabling a consistent material tensile force when continuing the 30: MC_Winder motion command
from a standstill: You can either maintain the calculated winding diameter during the axis standstill or temporarily specify a
start diameter via fieldbus when continuing the 30: MC_Winder motion command (maintain diameter: L28; start diameter:
L30).

Parameterizing the diameter calculator

Parameterize the minimum permitted velocity for calculating the winding diameter.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L02 Velocity minimum:

Select the minimum permitted velocity to be used for calculating the winding diameter.

Diameter calculator: Parameterizing the filter

If the quality of the signals requires it, as an option, you can define the velocity-dependent time constant for the filter of
the diameter calculator.

v' The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source > Diameter
calculator: Filter.

2. L80 Diameter calculator filter time constant, L81 Diameter calculator filter velocity:
To filter the actual material velocity as well as the actual velocity of the axis, define the velocity-dependent time
constants for the diameter calculator.

2.1. L80 Diameter calculator filter time constant:
If the quality of the signals requires it, define the time constants in L80[0] — [7] for the respective velocity in
L81[0] —[7].

2.2. L81 Diameter calculator filter velocity:
If the quality of the signals requires it, define the velocities in L81[0] — [7] for the respective time constant in
L80[0] - [7].

= The velocity-dependent time constant for the calculation of the winding diameter is calculated from the pairs of
values for L80 and L81 (display: L82).
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Parameterizing the start diameter

As an option, you can parameterize a start diameter to enable a more even material tensile force when continuing the
30: MC_Winder motion command from a standstill.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L30 Source activate start diameter:

Select the source for activating the start diameter.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.
2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
3. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

4. 131 Start diameter:

Define the desired start diameter.

Retaining the diameter: Parameterizing the source

As an option, you can parameterize a source for retaining the diameter to enable a more even material tensile force when
continuing the 30: MC_Winder motion command from a standstill.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L28 Source hold diameter:

If center winder control word L150 is the source for retaining the winding diameter, select 2: Parameter L150.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.

2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
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572.4 Compensating for friction and mass inertia

Friction compensation is essential for the correct display of the calculated actual material tensile force. If LOO = 1: Tensile
force control (open loop), the static and dynamic frictional torques of the axis absolutely must be determined and
compensated for in order to ensure a uniform winding result. If LOO = 2: Tensile force control, torque correction,
compensation for the friction can relieve the PID controller.

As an option, the constant and variable mass moments of inertia of the axis can also be determined and compensated for in
order to keep the material tensile force constant if the axis is accelerated. Parameterize compensation for the mass inertia
as described below.

If LOO = 1: Tensile force control (open loop), parameterize compensation for the friction as described below. For all other
winding methods, the compensation for friction and mass inertia is optional and only required for the correct display of the
calculated actual material tensile force (display: L481).

For more information on friction and mass inertia compensation, see Compensation for friction and mass inertia [ 102].

5.7.2.41 Determining frictional torques

Determine the static and dynamic frictional torque using the jog control panel and the respective formula as described
below.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause

unexpected axis movements.
= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Jog control panel: Determining operating points

To determine the static and dynamic frictional torque, move the center winder without material using the jog control panel
at 2 different velocities and write down the pair of values of velocity and associated torque for the 2 operating points.

v" There is an online connection between DriveControlSuite and the drive controller.

v" The winder case is empty; no material is wound up.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.
3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.
4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. 112 Jog velocity:
Define the lower velocity and move the axis according to the winding direction with Jog+ or Jog-.

6. 188 Actual speed, EO2 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as operating point 1 for the

calculation of the frictional torques (n,;, M, ;).

7. 112 Jog velocity:

Define the higher velocity and move the axis according to the winding direction with Jog+ or Jog-.

8. 188 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as operating point 2 for the

calculation of the frictional torques (n,,, M,,).

=  You have determined operating point 1 (n,,, M, ;) and operating point 2 (n,,, M, ) for the calculation of the frictional
torques.

Determining static and dynamic frictional torque
To calculate the static frictional torque Mg, and dynamic frictional torque Mg, you need the following absolute values:
= Qperating point 1 (lower velocity)
e M,,: torque at the gearbox output
* n,,:speed at the gearbox output
= QOperating point 2 (higher velocity)
e M,,: torque at the gearbox output
* n,,:speed at the gearbox output

Use the following formula for the measured value pairs to determine the dynamic frictional torque Mg,,, and write down
the result (target parameter: L120).

My = Mz,2 — M2,
Nn2,2 —N2,1
1000 min™

Fig. 4: Dynamic frictional torque Mg,
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Use the following formula for the measured value pairs to determine the static frictional torque M;,,,, and write down the

result (target parameter: L110).

Mrstat = M2, 2 — | Mrdyn x L = Ma2.1— | Mrayn x N2,1 _
1000 min~ 1000 min~

Fig. 5: Static frictional torque Mg,

Example
= Operating point 1 (lower velocity)
e M,,=12%
e n,,=500rpm
= Qperating point 2 (higher velocity)
e M,,=39%
® n,,=3000rpm
Mgayn = 39%-12% =10,8 %
3000 min~'-500 min™
1000 min™

Fig. 6: Example: Calculate Mg,

A
Mesit = 39 % — | 10,8 % x| 2000 MIN_ || _ 399, 32 4% = 6,6 %
1000 min

Fig. 7: Example: Calculate Mg,

57242 Compensating for friction

Compensate for the static and dynamic friction of the axis by converting the previously determined frictional torques into
the target parameters.

v" You have determined the static frictional torque Mg, of the axis.

v" You have determined the dynamic frictional torque Mgy, of the axis.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

3. L110 Frictional torque static:

Define the frictional torque for the compensation for the static friction of the axis.

4. L120 Frictional torque dynamic:

Define the frictional torque for the compensation for the dynamic friction of the axis.
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57243 Determining mass moments of inertia

To keep the material tensile force constant when the axis is accelerated, as an option, you can compensate for the constant
and variable mass inertia of the axis. To do so, determine the mass moments of inertia of the axis in accordance with the
respective component using the following formulas for solid cylinders or hollow cylinders.

lemﬁ
2

Fig. 8: Mass moment of inertia J (solid cylinder)

r12 4 ro?
2

Fig. 9: Mass moment of inertia J (hollow cylinder)

Determining the mass moment of inertia of the gearbox

The mass moment of inertia J, of the gearbox can be found in the technical data in the corresponding catalog (target
parameter: L200).

Determining the mass moment of inertia of the shaft, including winder case
To calculate the mass moment of inertia J of the shaft including winder case, you need the following values:

= Mass moment of inertia J of the shaft
e r:radius of the shaft

e m: weight of the shaft

= Mass moment of inertia J of the winder case
e r,:inner radius of the winder case
e r,:outer radius of the winder case

e m: weight of the winder case
Calculate the mass moment of inertia J of the shaft including winder case as follows:
1. Calculate the mass moment of inertia J of the shaft using the formula for solid cylinders.
2. Calculate the mass moment of inertia J of the winder case using the formula for hollow cylinders.

3. Add the mass moments of inertia J of the shaft and winder case and write down the result (target parameter: L220).

Determining the mass moment of inertia of the winding
To calculate the mass moment of inertia J of the winding without the shaft and winder case, you need the following values:
= Mass moment of inertia J of the winding
e _:inner radius of the winder with minimum winding diameter L0O3
e r,:outer radius of winder at maximum winding diameter L04

e m: weight of winder at maximum winding diameter L04

Calculate the mass moment of inertia J of the winder using the formula for hollow cylinders and write down the result
(target parameter: L240).
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57244 Compensating for mass inertia

To keep the material tensile force constant when the axis is accelerated, as an option, you can compensate for the mass

inertia of the axis by defining the previously determined mass moments of inertia for the corresponding parameters or

deactivate the function using the override.

v

v

v

1.

2.

You have determined the mass moment of inertia J; of the gearbox.
You have determined the mass moment of inertia J of the shaft including winder case.

You have determined the mass moment of inertia J of the winding at maximum winding diameter.
Select the Drive Based Center Winder application wizard > Center winder > Compensation.

L200 Gearbox mass moment of inertia:
Define the mass moment of inertia J of the gearbox for the compensation for the mass inertia of the axis.

L220 Mass moment of inertia shaft:
Define the mass moment of inertia J of the shaft and winder case for the compensation for the mass inertia of the

axis.

L240 Mass moment of inertia winding:
Define the mass moment of inertia J of the material at maximum winding diameter for compensating for the mass

inertia of the axis.

L301 Compensation mass moment of inertia override:

Define the override for the compensation for the mass moment of inertia of the axis; the value 0 disables the function.

Information

To prevent abrupt set value jumps, compensation for the mass moment of inertia should only be activated (L301 # 0) if the

set material velocity is ramped externally, since the derivation of the set material velocity is used for the compensation for

the mass moment of inertia.
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5.7.2.5 Parameterizing the set material velocity

The sign of the set material velocity defines the winding direction: If the set material velocity is positive, the center winder
winds up (increasing winding diameter); if the set material velocity is negative, it unwinds (decreasing winding diameter).

You can find more information on the winding direction under Winding direction [» 100].

Parameterizing the set material velocity

Parameterize the maximum permitted material velocity and, if necessary, the override for the set velocity of the motor and
optionally define the time constant for the filter of the set material velocity.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material velocity.

2. L400 Source set material velocity:

Select the source of the set material velocity.
2.1. If afieldbus is the source, select 4: Parameter L405.

3. L410 Material velocity maximum:

Define the maximum permitted material velocity.

4. L406 Set material velocity time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

5. LO7 Source velocity override:
If you selected 1: Tensile force control (open loop) = 2: Tensile force control, torque correction or LOO, select the

source of the velocity override for the set velocity of the motor.
5.1. To specify a relative velocity override, select 1: Relative.
5.2. To specify an absolute velocity override, select 2: Absolute.
5.3. To specify the relative and absolute velocity override, select 3: Relative + absolute.

6. LOS5 Velocity override relative:

If you have selected 1: Relative or 3: Relative + absolute for LO7, define the relative velocity override.

7. LO6 Velocity override absolute:

If you have selected 2: Absolute = 3: Relative + absolute for LO7, define the absolute velocity override.

Information

If LOO = 1: Tensile force control (open loop) and LOO = 2: Tensile force control, torque correction, the velocity override is
required to create a difference between the set velocity and actual velocity of the motor so that the required actual
material tensile force can be applied for a uniform winding result. The set material velocity is increased according to the
velocity override during winding and reduced accordingly during unwinding.
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5.7.2.6 Parameterizing the actual material velocity

If the winding diameter is calculated by the drive controller or if you have selected 5: Velocity control = LOO, parameterize

the source of the actual material velocity as described below.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Actual material velocity.

L452 Source actual material velocity:

Select the source of the actual material velocity.
2.1. If afieldbus is the source, select 4: Parameter L450.
2.2. If the actual material velocity is equal to the set material velocity, select 5: Parameter L420.
2.3. If a master encoder serves as the source for the actual material velocity, select 6: Parameter G105.

L410 Material velocity maximum:

Define the maximum permitted material velocity.

L456 Actual material velocity time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L458 Invert actual material velocity:
If you have selected 5: Velocity control = LOO, you may need to invert the sign of the actual material velocity so that

the signs of the actual material velocity and set material velocity match.

Information

If the diameter calculator serves as the source for the winding diameter, the drive controller calculates the winding

diameter from the absolute actual motor velocity and absolute actual material velocity. If LOO = 5: Velocity control, the signs

of the actual material velocity and set material velocity must match.

Make sure that the parameterized actual material velocity corresponds to the actual velocity of the material directly at the

winder so that the winding diameter, and consequently the set torque of the axis, can be calculated exactly for a uniform

winding result. The actual material velocity must correspond to the actual velocity of the material on the winder.
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5727 Parameterizing the master encoder

If a master encoder is used as the source for the actual material velocity, parameterize the master encoder as described
below.

Parameterizing the master encoder

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Encoder wizard > Master encoder: Scaling.

3. G104 Source master encoder:

Select the interface over which the master encoder is connected.

4. GA47 Distance factor numerator master, G48 Distance factor denominator master:

Define the conversion factor for the path of the master encoder in relation to the master position.
5. Select the Encoder wizard.

6. G297 maximum-speed master-encoder

Define the maximum permitted velocity for the master encoder.

Information

Parameterize G297 maximum-speed master-encoder according to your application case: If G297 is set too low, the
permitted maximum speed is exceeded even at normal operating speeds. If G297 is set too high, measuring errors of the
encoder can be overlooked.

G297 depends on the following parameters: G46 Decimal places, G47 Distance factor numerator master, G48 Distance
factor denominator master and G49 Master measure unit. If you have made changes to one of the parameters listed, adjust
G297 accordingly as well.

Master encoder: Parameterizing the interface

v" You have selected the interface for the master encoder (G104 # O: Inactive).
1. If you have connected the master encoder over the X4 interface, select the Encoder wizard > X4.

1.1. HOO X4 function:

Select the encoder model that is connected to the interface.
= The appropriate parameters are displayed based on the selected encoder model.

1.2. HO3 Encoder version:

Select whether the encoder design is rotational or translational.
1.3. Parameterize the interface according to the properties of the master encoder.

2. If you have connected the master encoder over the X101 or X103 (DI) interface, select the Encoder wizard > X101/
X103 (DI).

2.1. H40 DI encoder:
Select the encoder model that is connected to the interface.

= The appropriate parameters are displayed based on the selected encoder model.

2.2. H43 Encoder version:

Select whether the encoder design is rotational or translational.

2.3.  H41 DIl numerator, H42 DI denominator:

Parameterize the pair of values for scaling the encoder at the digital input.
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5.7.2.8 Parameterizing the set material tensile force

If you selected 1: Tensile force control (open loop) = 2: Tensile force control, torque correction, 3: Tensile force control,

velocity correction or LOO, parameterize the set material tensile force as described below.

Parameterizing the set material tensile force

Select the source and the mode for specifying the set material tensile force and optionally define the time constant for the

filter of the set material tensile force.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Set material tensile force.

L498 Source set material tensile force:

Select the source of the set material tensile force.
2.1. Ifafieldbus is the source, select 4: Parameter L496.

L497 Set material tensile force maximum:

Define the maximum permitted material tensile force.

L495 Set material tensile force time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L500 Set material tensile force mode:

Select the mode for specifying the set material tensile force.
5.1. If the set material tensile force is to be specified without changes, select 0: Direct set material tensile force.

5.2. If the set material tensile force is to be increased in proportion to the diameter, select 1: Set material tensile

force proportional to diameter.
5.3. If the set torque of the motor is to be kept constant regardless of the diameter, select 2: Constant torque.

5.4. If a diameter-dependent override is to be applied to the set material tensile force, select 3: Characteristic.

= The Set material tensile force: Curve wizard for parameterization of the diameter-dependent set material tensile
force override is displayed.

5.5. If the control word L150 of the center winder is the source for selecting the mode, select 4: Parameter L150.

Information

The required set torque for the axis is calculated from the specified set material tensile force and winding diameter.

Negative values for the set material tensile force are limited to 0. For a consistent winding result, make sure that the set

material tensile force is correctly parameterized.

Set material tensile force: Parameterizing the curve

If you want to modify the specified set material tensile force using a diameter-dependent override, define the value pairs of

winding diameter and set material tensile force override.

v

You want to modify the set material tensile force with a diameter-dependent override (L500 = 3: Characteristic or
4: Parameter L150).

Select the Drive Based Center Winder application wizard > Center winder > Set material tensile force > Set material

tensile force: Curve.

L600 Set material tensile force curve diameter, L610 Set material tensile force curve override:
Define the value pairs of winding diameter and set material tensile force override for the diameter-dependent set

material tensile force override.
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5.7.2.9 Parameterizing the actual material tensile force

If you have selected LOO = 2: Tensile force control, torque correction or 3: Tensile force control, velocity correction,

parameterize the source of the actual material tensile force as described below.

Parameterizing the actual material tensile force

Select the source for specifying the actual material tensile force and optionally define the time constant for the filter of the

actual material tensile force.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Actual material tensile force.

L492 Source actual material tensile force:

Select the source of the actual material tensile force.
2.1. If afieldbus is the source, select 4: Parameter L490.

L497 Set material tensile force maximum:

Define the maximum permitted material tensile force.

L489 Actual material tensile force time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

5.7.210 Parameterizing the dancer

If you have selected LOO = 4: Dancer position control, velocity correction, parameterize the dancer as described below.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Dancer.

L95 Dancer set position:

Define the set position of the dancer.

L90 Source dancer actual position:

Select the source of the actual dancer position.
3.1. Ifafieldbus is the source, select 4: Parameter L96.

L91 Dancer actual position Al unscaled, L92 Dancer actual position Al scaled:
If an analog input is used as the source, define the desired value range at the analog input and the desired value range

of the actual dancer position for scaling (unit: % = mm).

L93 Dancer actual position time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L97 Dancer set position minimum, L98 Dancer set position maximum:

Define the permitted value range for the set dancer position.
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5.7.21 Parameterizing the PID controller
If you have selected one of the following winding methods for LOO, parameterize the PID controller as described below.
= 2:Tensile force control, torque correction
= 3:Tensile force control, velocity correction
= 4: Dancer position control, velocity correction
= 5:Velocity control

You can find more information on the PID controller in the Drive Based Center Winder application under PID controller

[»103].

Parameterizing scaling
Parameterize the scaling of the inputs and outputs of the PID controller depending on the selected winding method.
1. Select the Drive Based Center Winder application wizard > Center winder.

2. L357 Material tensile force scaling:
If you have selected 2: Tensile force control, torque correction = 3: Tensile force control, velocity correction or LOO,

define the scaling of the material tensile force for the PID controller.

3. L358 Material velocity scaling:
If you have selected 3: Tensile force control, velocity correction = 4: Dancer position control, velocity correction or

5: Velocity control for LOO, define the scaling of the material velocity for the PID controller.

4. 1359 Dancer position scaling:
If you have selected 4: Dancer position control, velocity correction = LOO, define the scaling of the material tensile
force for the PID controller.

Parameterizing the PID controller
Parameterize the remaining settings of the PID controller independently of the selected winding method.
1. Select the Drive Based Center Winder application wizard > Center winder > PID controller.

2. L370 Source PID controller enable:

Select the source for the enable signal of the PID controller.
2.1. To set the PID controller as basically enabled, select 1: High.
2.2. If the control word of the application acts as the source, select 2: Parameter L150.
2.3. If adigital input (direct or inverted) acts as the source, select the corresponding input.

3. L350 Closed loop gain PID:
Define the loop gain K, of the PID controller.

4. 1351 Proportional factor PID:
Define the proportional coefficient K, of the PID controller.

5. L352 Integral factor PID:

Define the integral coefficient K, of the PID controller.

6. L353 Differentiation time PID:

Define the derivation time T, of the PID controller.

7. L354 Tau low pass D part PID:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

8. L355 Negative maximum value PID, L356 Positive maximum value PID:

Define the maximum permitted positive and maximum permitted negative manipulated variable of the PID controller.
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5.7.212 Parameterizing material tear monitoring

If you want to use material tear monitoring, select the desired source and optionally parameterize application event 0. If
LOO = 2: Tensile force control, torque correction and 3: Tensile force control, velocity correction, also define the minimum
permitted material tensile force when using the algorithm.

You can find more information on material tear monitoring under Material tear monitoring [» 103].

Parameterizing material tear monitoring

Parameterize the source of material tear monitoring and, if necessary, define the minimum permitted material tensile force
when using the algorithm.

1. Select the Drive Based Center Winder application wizard > Center winder > Material tear monitoring.

2. L381 Source material tear monitoring:

Select the source for material tear monitoring.
2.1. If asensoris the source, select 1: Sensor.
2.2. If you want to monitor the material tensile force using an algorithm, select 2: Algorithm.
2.3. Ifasensoris used as the source and you also want to use the algorithm, select 3: Algorithm + sensor.

3. L382 Material tensile force minimum:
If you have selected 2: Algorithm = 3: Algorithm + sensor for L381, define the minimum permitted actual material
tensile force for material tear monitoring if required (required for LOO = 2: Tensile force control, torque correction and

3: Tensile force control, velocity correction).
= When material tear monitoring is triggered, the corresponding bit is set in the status word of the application (signal:
L904; status word: L155, bit 7).
Parameterizing the material tear sensor

If a sensor is used as the source for material tear monitoring, parameterize the source for this (L381 = 1: Sensor or
3: Algorithm + sensor).

1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L1380 Source material tear sensor:

Select the source for the material tear sensor.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.

2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

Parameterizing application event 0

If you want to trigger application event 0 in the context of material tear monitoring, also parameterize the desired level for
the evaluation of the event.

1. Select the Protection functions wizard > Protection functions: Application.

2. U100 Level application event 0:

Select the desired level of protection for the material tear monitoring function.
2.1. To evaluate the event with low priority, select 1: Message.

2.2. To evaluate the event with medium priority and a fault reaction after the tolerance time has elapsed, select
2: Warning.

2.3. To evaluate the event with high priority and an immediate fault reaction, select 3: Fault.

3. U101 Time application event 0:
If you have selected for 2: Warning = U100, define the desired tolerance time after which the drive controller goes

into fault mode.
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5.7.213 Parameterizing the material length

If you want to calculate the material length on the winder based on the winding diameter, parameterize the material
thickness as well as an optional comparison value for the material length to set the corresponding bit in the status word of
the center winder when the comparison value is reached.

1. Select the Drive Based Center Winder application wizard > Center winder > Material length.

2. L40 Material thickness:
Define the material thickness for calculating the material length on the winder.

3. L42 Material length comparison value:

Define the comparison value for the material length on the winder.
The material length on the winder is calculated based on the current and maximum permitted diameter.

When the comparison value for the material length is reached, the corresponding bit is set in the status word of the
center winder (L155, bit 9).

Information

During winding, the comparison value is considered to have been reached when the material length has exceeded the
comparison value (L41 > L42). During unwinding, the comparison value is considered to have been reached when the
material length has fallen below the comparison value (L41 < L42).
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573 Parameterizing command operating mode
The following graphic shows the signal flows of the command operating mode. The elements shown in a lighter shade are
optional.
Controller
Alternative
sources
Controller Continue
DI function -
Controller
Override
Al

Fig. 10: Command operating mode: signal flows

In command operating mode, motion profiles are sent from a controller to the drive controller in the form of motion tasks.
A motion task includes a PLCopen-compliant motion command which defines the basic motion method of the axis. The
associated motion variables supply specifications on velocity, acceleration, deceleration and jerk, from which the motion
core of the drive controller calculates the motion profile.

The controller coordinates the time progression and selects the motion tasks for the drive controller that the positioning,
velocity and torque/force commands process and run. In the controller, you define the motion tasks. In the DS6, you
parameterize the signal sources from which the drive controller receives the motion tasks from the controller.

In command operating mode, drive controllers are either activated using a fieldbus or by a mixed operation of a fieldbus
and terminals.
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Proceed as follows ...

= Activate command operating mode.

= Parameterize the center winder.

Parameterize the source of the winding diameter (calculator or sensor).
Compensate for the friction and, optionally, the mass inertia of the axis.

Parameterize the required motion variables (material tensile force, material velocity, dancer position) according to
the winding method.

If necessary, parameterize the PID controller according to the winding method.

As an option, parameterize the material length or material tear monitoring.

= Optional: Limit torque/force using the operating mode.

= Parameterize the command-specific motion variables.

= Define the source for the start signal.

= Optional: Define the source for the continue signal.

You can find more information on the winding methods of the Drive Based Center Winder application under Winding

methods [P 91].

Information

The motion variables available for this operating mode that you configure in the software depend on your application case

as well as on additional project-specific factors such as the use of a controller or the type of data transmission (fieldbus,

terminals).

5.7.31

Activating command operating mode

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.

2. Select the Drive Based Center Winder application wizard.

3. Operating modes area:

Activate the Command operating mode option.

= The corresponding wizards are displayed.

59



5 | Commissioning

STOBER

5732

Parameterizing the center winder

Parameterize the center winder as described below to be able to use the 30: MC_Winder motion command for winding.

573.21

Selecting the winding method

Select the desired winding method for the center winder according to your application. Depending on the winding method,

it may be necessary to parameterize different motion variables and possibly the PID controller.

You can find more information on the winding methods of the Drive Based Center Winder application under Winding

methods [P 91].

1. Select the Drive Based Center Winder application wizard > Center winder.

2. LOO Center winder method:

Select the desired winding method for the center winder.

2.1

2.2.

2.3.

If the material velocity is the focus of the application, select 0: Velocity control (open loop) or 5: Velocity

control.

If the material tensile force is the focus of the application, select 1: Tensile force control (open loop), 2: Tensile

force control, torque correction or 3: Tensile force control, velocity correction.

If you are working with a dancer, select 4: Dancer position control, velocity correction.

3. L10 Source center winder polarity:

Select the direction of interpretation between the winding direction and motor movement, i.e. the relationship

between the signs of the set material velocity L420 and set velocity of the motor L102.

3.1

3.2.

3.3.

3.4.

If the signs of the set velocities are the same, select O: Positive.
If the signs of the set velocities are inverted, select 1: Negative.
If the control word of the center winder is the source, select 2: Parameter L150.

If a digital input (direct or inverted) acts as the source, select the corresponding input.

You can find more information on the winding direction under Winding direction [ 100].
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573.2.2 Parameterizing the diameter source

Parameterize the source of the winding diameter based on whether a sensor serves as the source for the diameter in your
drive project or whether the diameter is calculated by the drive controller. A sensor for the actual material velocity is
required for the calculation of the winding diameter by the drive controller. First configure the general settings as described
below, then parameterize either the diameter sensor or the diameter calculator, depending on the source.

You can find more information on the winding diameter under Winding diameter [» 98].

Parameterizing the diameter

Parameterize the minimum and maximum permitted winding diameters and optionally define the time constant for the
filter of the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

2. LO3 Minimal diameter:

Define the minimum permitted diameter of the winding (usually corresponds to the winder case).

3. LO4 Diameter maximum:

Define the maximum permitted diameter of the winding according to your application.

4. L1111 Diameter time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Parameterizing the diameter source
Select either a sensor or the diameter calculator as the source for the winding diameter.
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L20 Source diameter:

Select the source for the winding diameter.
2.1. If the drive controller is to calculate the winding diameter, select 0: Diameter calculator.
2.2. If asensor is the source for the winding diameter, select 1: Diameter sensor.

= The parameters and wizards for parameterization of the winding diameter are displayed according to the selected

source.
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Parameterizing the diameter change limit

As an option, you can limit the change in the winding diameter with regard to the winding direction, maximum permitted
change per second and, if applicable, change based on the axis enable signal.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Limitation: Diameter change.

2. L35 Source diameter change limitation:

Define whether the winding diameter is limited based on the winding direction.
2.1. If the winding diameter may change in both directions, select 0: Inactive.
2.2. If the winding diameter may only change in the winding direction, select 1: Active.

2.3. If the control word of the center winder is used as the source for limiting the diameter change, select
3: Parameter L150.

2.4. |If adigital input (direct or inverted) acts as the source, select the corresponding input.

3. L36 Diameter change maximum:

As an option, you can define the maximum permitted change in the winding diameter per second.

4. L37 Diameter change limit enable dependent:

Select whether the diameter change limit should pause in case of Enable-off (e.g. to replace the winder case).
4.1. To limit the diameter change independently of the enable signal, select 0: Inactive.
4.2. To limit the diameter change depending on the enable signal, select 1: Active.

You can find more information on the winding direction under Winding direction [» 100].

5.73.221 Parameterizing the diameter sensor
If a sensor serves as the source for the winding diameter, parameterize a fieldbus as the source.
v' The winding diameter is measured using a sensor (L20 = 1: Diameter sensor).
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L21 Source diameter sensor:

Select the source for the diameter sensor.

2.1. Ifafieldbus is the source, select 4: Parameter L25.
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573.2.2.2 Parameterizing the diameter calculator

If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as described below.

Information

The winding diameter is required for a consistent calculation of the material tensile force. When L20 = 0: Diameter
calculator, it is calculated by the drive controller from the actual velocity of the motor and actual material velocity, among
other factors. Accordingly, the winding diameter cannot be calculated when the axis is at a standstill. This means that,
depending on the actual winding diameter, a material tensile force that is temporarily too low can result when continuing
the 30: MC_Winder motion command.

There are 2 options for enabling a consistent material tensile force when continuing the 30: MC_Winder motion command
from a standstill: You can either maintain the calculated winding diameter during the axis standstill or temporarily specify a
start diameter via fieldbus when continuing the 30: MC_Winder motion command (maintain diameter: L28; start diameter:
L30).

Parameterizing the diameter calculator

Parameterize the minimum permitted velocity for calculating the winding diameter.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source.

2. L02 Velocity minimum:

Select the minimum permitted velocity to be used for calculating the winding diameter.

Diameter calculator: Parameterizing the filter

If the quality of the signals requires it, as an option, you can define the velocity-dependent time constant for the filter of
the diameter calculator.

v' The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter > Diameter: Source > Diameter
calculator: Filter.

2. L80 Diameter calculator filter time constant, L81 Diameter calculator filter velocity:
To filter the actual material velocity as well as the actual velocity of the axis, define the velocity-dependent time
constants for the diameter calculator.

2.1. L80 Diameter calculator filter time constant:
If the quality of the signals requires it, define the time constants in L80[0] — [7] for the respective velocity in
L81[0] —[7].

2.2. L81 Diameter calculator filter velocity:
If the quality of the signals requires it, define the velocities in L81[0] — [7] for the respective time constant in
L80[0] - [7].

= The velocity-dependent time constant for the calculation of the winding diameter is calculated from the pairs of
values for L80 and L81 (display: L82).
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Parameterizing the start diameter

As an option, you can parameterize a start diameter to enable a more even material tensile force when continuing the
30: MC_Winder motion command from a standstill.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L30 Source activate start diameter:

Select the source for activating the start diameter.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.
2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
3. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

4. 131 Start diameter:

Define the desired start diameter.

Retaining the diameter: Parameterizing the source

As an option, you can parameterize a source for retaining the diameter to enable a more even material tensile force when
continuing the 30: MC_Winder motion command from a standstill.

v" The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).
1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L28 Source hold diameter:

If center winder control word L150 is the source for retaining the winding diameter, select 2: Parameter L150.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.

2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
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573.23 Compensating for friction and mass inertia

Friction compensation is essential for the correct display of the calculated actual material tensile force. If LOO = 1: Tensile
force control (open loop), the static and dynamic frictional torques of the axis absolutely must be determined and
compensated for in order to ensure a uniform winding result. If LOO = 2: Tensile force control, torque correction,
compensation for the friction can relieve the PID controller.

As an option, the constant and variable mass moments of inertia of the axis can also be determined and compensated for in
order to keep the material tensile force constant if the axis is accelerated. Parameterize compensation for the mass inertia
as described below.

If LOO = 1: Tensile force control (open loop), parameterize compensation for the friction as described below. For all other
winding methods, the compensation for friction and mass inertia is optional and only required for the correct display of the
calculated actual material tensile force (display: L481).

For more information on friction and mass inertia compensation, see Compensation for friction and mass inertia [ 102].

573.2.31 Determining frictional torques

Determine the static and dynamic frictional torque using the jog control panel and the respective formula as described
below.

/A WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.
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Jog control panel: Determining operating points

To determine the static and dynamic frictional torque, move the center winder without material using the jog control panel
at 2 different velocities and write down the pair of values of velocity and associated torque for the 2 operating points.

v" There is an online connection between DriveControlSuite and the drive controller.

v" The winder case is empty; no material is wound up.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.
3. Click Control panel on and then Enable.
= The axis is monitored via the active control panel.
4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. 112 Jog velocity:
Define the lower velocity and move the axis according to the winding direction with Jog+ or Jog-.

6. 188 Actual speed, EO2 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as operating point 1 for the

calculation of the frictional torques (n,;, M, ;).

7. 112 Jog velocity:

Define the higher velocity and move the axis according to the winding direction with Jog+ or Jog-.

8. 188 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as operating point 2 for the

calculation of the frictional torques (n,,, M,,).

=  You have determined operating point 1 (n,,, M, ;) and operating point 2 (n,,, M, ) for the calculation of the frictional
torques.

Determining static and dynamic frictional torque
To calculate the static frictional torque Mg, and dynamic frictional torque Mg, you need the following absolute values:
= Qperating point 1 (lower velocity)
e M,,: torque at the gearbox output
* n,,:speed at the gearbox output
= QOperating point 2 (higher velocity)
e M,,: torque at the gearbox output
* n,,:speed at the gearbox output

Use the following formula for the measured value pairs to determine the dynamic frictional torque Mg,,, and write down
the result (target parameter: L120).

My = Mz,2 — M2,
Nn2,2 —N2,1
1000 min™

Fig. 11: Dynamic frictional torque Mg,
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Use the following formula for the measured value pairs to determine the static frictional torque M;,,,, and write down the
result (target parameter: L110).

Mrstat = M2, 2 — | Mrdyn x L = Ma2.1— | Mrayn x N2,1 _
1000 min~ 1000 min~

Fig. 12: Static frictional torque Mg,

Example
= Operating point 1 (lower velocity)
e M,,=12%
e n,,=500rpm
= Qperating point 2 (higher velocity)
e M,,=39%
® n,,=3000rpm
Mgayn = 39%-12% =10,8 %
3000 min~'-500 min™
1000 min™

Fig. 13: Example: Calculate Mgy,

A
Mesit = 39 % — | 10,8 % x| 2000 MIN_ || _ 399, 32 4% = 6,6 %
1000 min

Fig. 14: Example: Calculate Mg,

57.3.2.3.2 Compensating for friction

Compensate for the static and dynamic friction of the axis by converting the previously determined frictional torques into
the target parameters.

v" You have determined the static frictional torque Mg, of the axis.

v’ You have determined the dynamic frictional torque Mg, of the axis.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

3. L110 Frictional torque static:
Define the frictional torque for the compensation for the static friction of the axis.

4. L120 Frictional torque dynamic:
Define the frictional torque for the compensation for the dynamic friction of the axis.
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573.2.3.3 Determining mass moments of inertia

To keep the material tensile force constant when the axis is accelerated, as an option, you can compensate for the constant
and variable mass inertia of the axis. To do so, determine the mass moments of inertia of the axis in accordance with the
respective component using the following formulas for solid cylinders or hollow cylinders.

lemﬁ
2

Fig. 15: Mass moment of inertia J (solid cylinder)

r12 4 ro?
2

Fig. 16: Mass moment of inertia J (hollow cylinder)

Determining the mass moment of inertia of the gearbox

The mass moment of inertia J, of the gearbox can be found in the technical data in the corresponding catalog (target
parameter: L200).

Determining the mass moment of inertia of the shaft, including winder case
To calculate the mass moment of inertia J of the shaft including winder case, you need the following values:

= Mass moment of inertia J of the shaft
e r:radius of the shaft

e m: weight of the shaft

= Mass moment of inertia J of the winder case
e r,:inner radius of the winder case
e r,:outer radius of the winder case

e m: weight of the winder case
Calculate the mass moment of inertia J of the shaft including winder case as follows:
1. Calculate the mass moment of inertia J of the shaft using the formula for solid cylinders.
2. Calculate the mass moment of inertia J of the winder case using the formula for hollow cylinders.

3. Add the mass moments of inertia J of the shaft and winder case and write down the result (target parameter: L220).

Determining the mass moment of inertia of the winding
To calculate the mass moment of inertia J of the winding without the shaft and winder case, you need the following values:
= Mass moment of inertia J of the winding
e _:inner radius of the winder with minimum winding diameter L0O3
e r,:outer radius of winder at maximum winding diameter L04

e m: weight of winder at maximum winding diameter L04

Calculate the mass moment of inertia J of the winder using the formula for hollow cylinders and write down the result
(target parameter: L240).
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573.2.3.4 Compensating for mass inertia

To keep the material tensile force constant when the axis is accelerated, as an option, you can compensate for the mass

inertia of the axis by defining the previously determined mass moments of inertia for the corresponding parameters or

deactivate the function using the override.

v

v

v

1.

2.

You have determined the mass moment of inertia J; of the gearbox.
You have determined the mass moment of inertia J of the shaft including winder case.

You have determined the mass moment of inertia J of the winding at maximum winding diameter.
Select the Drive Based Center Winder application wizard > Center winder > Compensation.

L200 Gearbox mass moment of inertia:
Define the mass moment of inertia J of the gearbox for the compensation for the mass inertia of the axis.

L220 Mass moment of inertia shaft:
Define the mass moment of inertia J of the shaft and winder case for the compensation for the mass inertia of the

axis.

L240 Mass moment of inertia winding:
Define the mass moment of inertia J of the material at maximum winding diameter for compensating for the mass

inertia of the axis.

L301 Compensation mass moment of inertia override:

Define the override for the compensation for the mass moment of inertia of the axis; the value 0 disables the function.

Information

To prevent abrupt set value jumps, compensation for the mass moment of inertia should only be activated (L301 # 0) if the

set material velocity is ramped externally, since the derivation of the set material velocity is used for the compensation for

the mass moment of inertia.
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57324 Parameterizing the set material velocity

The sign of the set material velocity defines the winding direction: If the set material velocity is positive, the center winder
winds up (increasing winding diameter); if the set material velocity is negative, it unwinds (decreasing winding diameter).

You can find more information on the winding direction under Winding direction [» 100].

Parameterizing the set material velocity

Parameterize the maximum permitted material velocity and, if necessary, the override for the set velocity of the motor and
optionally define the time constant for the filter of the set material velocity.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material velocity.

2. L400 Source set material velocity:

Select the source of the set material velocity.
2.1. If afieldbus is the source, select 4: Parameter L405.

3. L410 Material velocity maximum:

Define the maximum permitted material velocity.

4. L406 Set material velocity time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

5. LO7 Source velocity override:
If you selected 1: Tensile force control (open loop) = 2: Tensile force control, torque correction or LOO, select the

source of the velocity override for the set velocity of the motor.
5.1. To specify a relative velocity override, select 1: Relative.
5.2. To specify an absolute velocity override, select 2: Absolute.
5.3. To specify the relative and absolute velocity override, select 3: Relative + absolute.

6. LOS5 Velocity override relative:

If you have selected 1: Relative or 3: Relative + absolute for LO7, define the relative velocity override.

7. LO6 Velocity override absolute:

If you have selected 2: Absolute = 3: Relative + absolute for LO7, define the absolute velocity override.

Information

If LOO = 1: Tensile force control (open loop) and LOO = 2: Tensile force control, torque correction, the velocity override is
required to create a difference between the set velocity and actual velocity of the motor so that the required actual
material tensile force can be applied for a uniform winding result. The set material velocity is increased according to the
velocity override during winding and reduced accordingly during unwinding.
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5.7.3.25 Parameterizing the actual material velocity

If the winding diameter is calculated by the drive controller or if you have selected 5: Velocity control = LOO, parameterize

the source of the actual material velocity as described below.

1.

2.

If the diameter calculator serves as the source for the winding diameter, the drive controller calculates the winding
diameter from the absolute actual motor velocity and absolute actual material velocity. If LOO = 5: Velocity control, the signs

Select the Drive Based Center Winder application wizard > Center winder > Actual material velocity.

L452 Source actual material velocity:

Select the source of the actual material velocity.
2.1. If afieldbus is the source, select 4: Parameter L450.
2.2. If the actual material velocity is equal to the set material velocity, select 5: Parameter L420.
2.3. If a master encoder serves as the source for the actual material velocity, select 6: Parameter G105.

L410 Material velocity maximum:

Define the maximum permitted material velocity.

L456 Actual material velocity time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L458 Invert actual material velocity:

If you have selected 5: Velocity control = LOO, you may need to invert the sign of the actual material velocity so that

the signs of the actual material velocity and set material velocity match.

Information

of the actual material velocity and set material velocity must match.

Make sure that the parameterized actual material velocity corresponds to the actual velocity of the material directly at the
winder so that the winding diameter, and consequently the set torque of the axis, can be calculated exactly for a uniform

winding result. The actual material velocity must correspond to the actual velocity of the material on the winder.
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573.2.6 Parameterizing the master encoder

If a master encoder is used as the source for the actual material velocity, parameterize the master encoder as described
below.

Parameterizing the master encoder

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.
2. Select the Encoder wizard > Master encoder: Scaling.

3. G104 Source master encoder:

Select the interface over which the master encoder is connected.

4. GA47 Distance factor numerator master, G48 Distance factor denominator master:

Define the conversion factor for the path of the master encoder in relation to the master position.
5. Select the Encoder wizard.

6. G297 maximum-speed master-encoder

Define the maximum permitted velocity for the master encoder.

Information

Parameterize G297 maximum-speed master-encoder according to your application case: If G297 is set too low, the
permitted maximum speed is exceeded even at normal operating speeds. If G297 is set too high, measuring errors of the
encoder can be overlooked.

G297 depends on the following parameters: G46 Decimal places, G47 Distance factor numerator master, G48 Distance
factor denominator master and G49 Master measure unit. If you have made changes to one of the parameters listed, adjust
G297 accordingly as well.

Master encoder: Parameterizing the interface

v" You have selected the interface for the master encoder (G104 # O: Inactive).
1. If you have connected the master encoder over the X4 interface, select the Encoder wizard > X4.

1.1. HOO X4 function:

Select the encoder model that is connected to the interface.

= The appropriate parameters are displayed based on the selected encoder model.

1.2. HO3 Encoder version:

Select whether the encoder design is rotational or translational.
1.3. Parameterize the interface according to the properties of the master encoder.

2. If you have connected the master encoder over the X101 or X103 (DI) interface, select the Encoder wizard > X101/
X103 (DI).

2.1. H40 Dl encoder:

Select the encoder model that is connected to the interface.
= The appropriate parameters are displayed based on the selected encoder model.
2.2. H43 Encoder version:

Select whether the encoder design is rotational or translational.

2.3. H41 DIl numerator, H42 DI denominator:

Parameterize the pair of values for scaling the encoder at the digital input.
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573.2.7 Parameterizing the set material tensile force

If you selected 1: Tensile force control (open loop) = 2: Tensile force control, torque correction, 3: Tensile force control,

velocity correction or LOO, parameterize the set material tensile force as described below.

Parameterizing the set material tensile force

Select the source and the mode for specifying the set material tensile force and optionally define the time constant for the

filter of the set material tensile force.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Set material tensile force.

L498 Source set material tensile force:

Select the source of the set material tensile force.
2.1. Ifafieldbus is the source, select 4: Parameter L496.

L497 Set material tensile force maximum:

Define the maximum permitted material tensile force.

L495 Set material tensile force time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L500 Set material tensile force mode:

Select the mode for specifying the set material tensile force.
5.1. If the set material tensile force is to be specified without changes, select 0: Direct set material tensile force.

5.2. If the set material tensile force is to be increased in proportion to the diameter, select 1: Set material tensile

force proportional to diameter.
5.3. If the set torque of the motor is to be kept constant regardless of the diameter, select 2: Constant torque.

5.4. If a diameter-dependent override is to be applied to the set material tensile force, select 3: Characteristic.

= The Set material tensile force: Curve wizard for parameterization of the diameter-dependent set material tensile
force override is displayed.

5.5. If the control word L150 of the center winder is the source for selecting the mode, select 4: Parameter L150.

Information

The required set torque for the axis is calculated from the specified set material tensile force and winding diameter.

Negative values for the set material tensile force are limited to 0. For a consistent winding result, make sure that the set

material tensile force is correctly parameterized.
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Set material tensile force: Parameterizing the curve

If you want to modify the specified set material tensile force using a diameter-dependent override, define the value pairs of

winding diameter and set material tensile force override.

v’ You want to modify the set material tensile force with a diameter-dependent override (L500 = 3: Characteristic or

4: Parameter L150).

1. Select the Drive Based Center Winder application wizard > Center winder > Set material tensile force > Set material
tensile force: Curve.
2. L600 Set material tensile force curve diameter, L610 Set material tensile force curve override:
Define the value pairs of winding diameter and set material tensile force override for the diameter-dependent set
material tensile force override.
573.2.8 Parameterizing the actual material tensile force

If you have selected LOO = 2: Tensile force control, torque correction or 3: Tensile force control, velocity correction,

parameterize the source of the actual material tensile force as described below.

Parameterizing the actual material tensile force

Select the source for specifying the actual material tensile force and optionally define the time constant for the filter of the

actual material tensile force.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Actual material tensile force.

L492 Source actual material tensile force:

Select the source of the actual material tensile force.
2.1. If afieldbus is the source, select 4: Parameter L490.

L497 Set material tensile force maximum:

Define the maximum permitted material tensile force.

L489 Actual material tensile force time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

573.2.9 Parameterizing the dancer

If you have selected LOO = 4: Dancer position control, velocity correction, parameterize the dancer as described below.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > Dancer.

L95 Dancer set position:

Define the set position of the dancer.

L90 Source dancer actual position:

Select the source of the actual dancer position.
3.1. If afieldbus is the source, select 4: Parameter L96.

L91 Dancer actual position Al unscaled, L92 Dancer actual position Al scaled:
If an analog input is used as the source, define the desired value range at the analog input and the desired value range

of the actual dancer position for scaling (unit: % - mm).

L93 Dancer actual position time constant:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L97 Dancer set position minimum, L98 Dancer set position maximum:

Define the permitted value range for the set dancer position.
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5.7.3.210 Parameterizing the PID controller

If you have selected one of the following winding methods for LOO, parameterize the PID controller as described below.

= 2:Tensile force control, torque correction

= 3:Tensile force control, velocity correction

= 4: Dancer position control, velocity correction

= 5:Velocity control

You can find more information on the PID controller in the Drive Based Center Winder application under PID controller

[»103].

Parameterizing scaling

Parameterize the scaling of the inputs and outputs of the PID controller depending on the selected winding method.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder.

L357 Material tensile force scaling:

If you have selected 2: Tensile force control, torque correction = 3: Tensile force control, velocity correction or LOO,

define the scaling of the material tensile force for the PID controller.

L358 Material velocity scaling:

If you have selected 3: Tensile force control, velocity correction = 4: Dancer position control, velocity correction or

5: Velocity control for LOO, define the scaling of the material velocity for the PID controller.

L359 Dancer position scaling:

If you have selected 4: Dancer position control, velocity correction = LOO, define the scaling of the material tensile

force for the PID controller.

Parameterizing the PID controller

Parameterize the remaining settings of the PID controller independently of the selected winding method.

1.

2.

Select the Drive Based Center Winder application wizard > Center winder > PID controller.

L370 Source PID controller enable:

Select the source for the enable signal of the PID controller.
2.1. Toset the PID controller as basically enabled, select 1: High.

2.2. If the control word of the application acts as the source, select 2: Parameter L150.

2.3. If adigital input (direct or inverted) acts as the source, select the corresponding input.

L350 Closed loop gain PID:
Define the loop gain K, of the PID controller.

L351 Proportional factor PID:
Define the proportional coefficient K, of the PID controller.

L352 Integral factor PID:

Define the integral coefficient K, of the PID controller.

L353 Differentiation time PID:

Define the derivation time T, of the PID controller.

L354 Tau low pass D part PID:

If the quality of the signal requires it, adjust the time constant for the filter accordingly.

L355 Negative maximum value PID, L356 Positive maximum value PID:

Define the maximum permitted positive and maximum permitted negative manipulated variable of the PID controller.
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57321 Parameterizing material tear monitoring

If you want to use material tear monitoring, select the desired source and optionally parameterize application event 0. If
LOO = 2: Tensile force control, torque correction and 3: Tensile force control, velocity correction, also define the minimum
permitted material tensile force when using the algorithm.

You can find more information on material tear monitoring under Material tear monitoring [» 103].

Parameterizing material tear monitoring

Parameterize the source of material tear monitoring and, if necessary, define the minimum permitted material tensile force
when using the algorithm.

1. Select the Drive Based Center Winder application wizard > Center winder > Material tear monitoring.

2. L381 Source material tear monitoring:

Select the source for material tear monitoring.
2.1. If asensoris the source, select 1: Sensor.
2.2. If you want to monitor the material tensile force using an algorithm, select 2: Algorithm.
2.3. Ifasensoris used as the source and you also want to use the algorithm, select 3: Algorithm + sensor.

3. L382 Material tensile force minimum:
If you have selected 2: Algorithm = 3: Algorithm + sensor for L381, define the minimum permitted actual material
tensile force for material tear monitoring if required (required for LOO = 2: Tensile force control, torque correction and

3: Tensile force control, velocity correction).
= When material tear monitoring is triggered, the corresponding bit is set in the status word of the application (signal:
L904; status word: L155, bit 7).
Parameterizing the material tear sensor

If a sensor is used as the source for material tear monitoring, parameterize the source for this (L381 = 1: Sensor or
3: Algorithm + sensor).

1. Select the Drive Based Center Winder application wizard > Data sources > Center winder digital signals: Data source.

2. L1380 Source material tear sensor:

Select the source for the material tear sensor.
2.1. If the control word of the center winder is the source, select 2: Parameter L150.

2.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.

Parameterizing application event 0

If you want to trigger application event 0 in the context of material tear monitoring, also parameterize the desired level for
the evaluation of the event.

1. Select the Protection functions wizard > Protection functions: Application.

2. U100 Level application event 0:

Select the desired level of protection for the material tear monitoring function.
2.1. To evaluate the event with low priority, select 1: Message.

2.2. To evaluate the event with medium priority and a fault reaction after the tolerance time has elapsed, select
2: Warning.

2.3. To evaluate the event with high priority and an immediate fault reaction, select 3: Fault.

3. U101 Time application event 0:
If you have selected for 2: Warning = U100, define the desired tolerance time after which the drive controller goes

into fault mode.
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573.212 Parameterizing the material length

If you want to calculate the material length on the winder based on the winding diameter, parameterize the material
thickness as well as an optional comparison value for the material length to set the corresponding bit in the status word of
the center winder when the comparison value is reached.

1. Select the Drive Based Center Winder application wizard > Center winder > Material length.

2. L40 Material thickness:
Define the material thickness for calculating the material length on the winder.

3. L42 Material length comparison value:

Define the comparison value for the material length on the winder.
The material length on the winder is calculated based on the current and maximum permitted diameter.

When the comparison value for the material length is reached, the corresponding bit is set in the status word of the
center winder (L155, bit 9).

Information

During winding, the comparison value is considered to have been reached when the material length has exceeded the
comparison value (L41 > L42). During unwinding, the comparison value is considered to have been reached when the
material length has fallen below the comparison value (L41 < L42).

5733 Limiting the torque/force using the operating mode

Basic torque/force limiting using the mechanical system takes place in the project configuration of the axis model. As an
option, you can parameterize an additional torque/force limit via the operating mode.

1. Select the Drive Based Center Winder application wizard > Command operating mode.

2. J47 Maximum positive torque/force, J48 Maximum negative torque/force:

Enter the maximum permitted positive and negative values for torque/force.

Information

The mechanical limit for torque/force is executed by C03 Maximum positive torque/force and CO5 Maximum negative
torque/force using the axis model. The additional limit using the operating mode is optional and refers to the values that
you defined in the axis model (reference values: C03, C05).
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5734 Parameterizing command-specific motion variables

The parameters for the acceleration, deceleration and jerk motion variables are not included as standard in the process
data mapping. You can either store the values for the motion variables permanently on the drive controller or add the
corresponding parameters to the process data mapping in order to receive the values from the controller.

Information

Before you start parameterizing the operating mode-specific motion variables, parameterize the general motion variables
and signal sources. If you obtain set values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and signal sources [P 35].

5.7.3.41 Storing motion variables: Drive controller

If you want to store the specifications for acceleration, deceleration and jerk permanently on the drive controller, check the
default values in the Command operating mode wizard and, if necessary, adjust them to your drive project.

v" You have activated command operating mode.

v' Parameters J44, J45 and J46 are not part of the process data mapping.
1. Select the Drive Based Center Winder application wizard > Command operating mode.

2. )44 Acceleration, J45 Deceleration, J46 Jerk:

Define the set values for acceleration, deceleration and jerk.

= The specifications for acceleration, deceleration and jerk are permanently stored on the drive controller.

Information

The parameters in the Command operating mode wizard are written by the controller once there is an online connection
between the drive controller and controller and provided that the parameters are part of the process data mapping. In this
state, you can read off the values in the parameters that the drive controller receives from the controller. Using parameter
J41 Motion-ID, you can identify the ongoing motion task in order to assign the status bit correctly.
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57342 Storing motion variables: Process data mapping

If you want to specify the settings for acceleration, deceleration and jerk via a controller, add the required parameters to

both the receive process data of the drive controller and the transmit process data of the controller.

Information

When using double-axis controllers and axis-specific parameters, make sure that the axis is addressed correctly (axis A:

lstCoordinate; axis B: 2ndCoordinate). They can only access the parameters of their own axis.

EtherCAT: Supplementing motion variables in PDO mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive

process data of the drive controller.

v’ You have activated command operating mode.

1.

2.

Select the EtherCAT wizard > Received process data RxPDO.

Coordinate column:

Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.
2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

= The parameter is applied to the receive process data of the drive controller.

In the Name, Data type and Length columns, your information about the parameters is displayed.

Add your changes to the process data mapping also to the transmit process data of the controller.

PROFINET: Supplementing motion variables in PZD mapping

If you want to specify values for motion variables using a controller, supplement the desired parameters in the receive

process data of the drive controller.

v" You have activated command operating mode.

1.

2.

Select the PROFINET wizard > Received process data RxPZD.

Coordinate column:

Enter the coordinate of the parameter that you want to apply to the process data mapping in the Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.
2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

= The parameter is applied to the receive process data of the drive controller.

In the Name, Data type and Length columns, your information about the parameters is displayed.

Add your changes to the process data mapping also to the transmit process data of the controller.
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5735 Parameterizing the start signal

Define the source for the execute signal in order to start a motion command selected in J40 in command operating mode.
1. Select the Drive Based Center Winder application > Data sources > Application digital signals: Data source.
2. 1100 Source execute:
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control word 1210 of the application acts as the source, select 2: Parameter.

= Bit 0 of the control word is set as the data source.

573.6 Parameterizing the continue signal

To use the continue function to resume an interrupted movement command, configure the source of the continue signal. If
you do not use the continue function, select a new command using J40 and start it using the start signal (execute).

You can find more information on the continue function, continuable motion commands and reasons for canceling under
Continue function.

1. Select the Drive Based Center Winder application > Command operating mode > Operating mode digital signals: Data

source.

2. )38 Source continue:

To use the continue function to resume interrupted motion commands, select the source for the continue signal.
2.1. If adigital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte J37 for the command operating mode acts as the source, select 2: Parameter.

= Bit 0 of the control byte is set as the source.
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§) More on Drive Based Center Winder?

The following chapters summarize the important terms, modules and relationships concerning Drive Based Center Winder.

6.1 Drive Based Center Winder — Concept

Applications such as Drive Based Center Winder, which calculate and adjust the motions in the drive itself, are referred to
as drive-based systems. They are either networked via a fieldbus or obtain signals and set values using analog and digital
hardware inputs.

The Drive Based Center Winder application provides you with a standard set of motion commands based on PLCopen,
which is supplemented by your own motion commands and thus offers flexible drive-based motion control for the position,
velocity and torque/force control types.

The motion commands are combined into corresponding operating modes for different applications. Depending on the
selected operating mode, the motion variables required for parameterizing individual motion profiles, such as set or limit
values, are recorded.

Based on all parameterized data, the motion core finally calculates an individual motion profile. Specified set values are
transmitted to the control cascade, which in turn activates the motor.

Additional wizards such as control panels or jog mode help with commissioning and the configuration test or are designed
for emergency operation.

The following graphic shows the components and configuration steps for the Drive Based Center Winder application. The
elements shown in a lighter shade are optional.

Data sources

Scaling
Auxiliary Jog Control Configuring the
functions mode panels motion profile

Referencing
methods

Calculating the
motion profile

Controlling the motor

Carrying out the
motion profile

o-H-H-H-:

Fig. 17: Components and configuration steps
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6.1.1 Operating modes

The operating modes of the Drive Based Center Winder application involve command sets bundled by application for
configuring individual motion profiles for production operation.

Thanks to flexible, user-defined adjustment options for the operating modes, the Drive Based Center Winder application
offers a compact — yet extremely variable — scope of functions that is suitable for a wide range of application cases in drive
technology. After selecting the suitable operating mode for the respective application case, users concentrate just on
parameterizing the most important sequences for their application.

Note that a drive controller can only process one operating mode per axis.

6.11.1 Center winder

Center winder operating mode is reduced to the 30: MC_Winder motion command, which is essential for winding. It is used
to calculate the set values for the center winder according to the selected control method.

The set and actual values for motion variables, such as the material tensile force or material velocity, can be taken into
account either by a controller via fieldbus or via the analog inputs, depending on the drive controller series.

Typical application examples are winding applications such as winding, unwinding or rewinding materials such as plastic,
wire, textiles or paper.

6.11.2 Command

Command operating mode enables a drive controller to run parameterizable motions. In this process, a range of motion
commands are processed that correspond to the behavior of the motion control blocks of the PLCopen standard.

A controller coordinates the time sequences by selecting motion commands based on PLCopen, such as MC_MoveAbsolute
(move to absolute set position) or MC_MoveRelative (move relative to actual position).

Parameters such as set position, velocity or torque limit can be defined individually.

Typical application examples are individual axis movements that are communicated by a controller (PLC) to the drive
controller.

6.1.2 Jog mode

For commissioning, emergency operation and maintenance or repair work, the manufacturer-specific jog mode (manual
movement) is available. Using jog mode, you can move the drive independently of the controller, for example.

You can use jog mode either through the jog control panel or a controller that applies the manual movement.
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6.1.3 Control panels

The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application in the respective operating mode before you switch to normal operation.

The following control panels are available:
= Jog control panel is used to check the projected axis model in jog mode.

= Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

6.1.4 Motion core

Based on the projected and parameterized data, the motion core calculates a motion profile and associated detail
movements as a basis for the drive controller as well as mandatory set values for the control cascade.

6.1.5 Data sources

The signals that activate a drive controller can be obtained from different data sources.
Each of the possible operating modes has a set of set values that is permanently stored in the software. Furthermore,
signals exist for the motion start or motion limits or velocity specifications that generally come from external data sources.

A fieldbus commonly acts as the signal source, though analog or digital hardware inputs or even a mixed operation made up
of the above-listed data sources are also possible.

Values that are obtained from external data sources are usually adapted to the stored reference values automatically, i.e.
calibrated and calculated with scaling.
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6.1.6 Additional functions

Each of the available operating modes can be expanded by drive-based additional functions. For example, these offer
convenient monitoring of process variables such as position, velocity or torque/force (cams, comparators) or control of
external process variables (PID controller).

6.1.6.1 Additional counter function

The additional counter function in Drive Based type applications provides you with up to 4 independent counters with
which you can implement smaller automation tasks directly in the drive controller, such as direct or indirect control of the
digital outputs.

Function

For each counter, you define a comparison value, a digital signal for increasing the counter reading and a digital signal for
resetting the counter reading (comparison value: N41; increase source: N43; reset source: N46). With each rising edge of
the counter signal, the counter reading is increased by 1 until the comparison value is reached (counter reading: N44).
When the comparison value is reached, a status signal is issued and further counter signals are ignored until the counter
reading is reset or the comparison value is increased (status: N42).

Signals
A
Counting
I I I I >
| I T T T R B t
| | | | | | | |
———————————————— AT T TTTOTT T
Reset | [ N R I | I | _
™
Counter reading
3 = Comparison value
2 I T N
_______________ I I P Y I R S
1 | | T
_______________ ) —-:-—1'——' _'I__
0 : [ I R _
>

Fig. 18: Additional counter function: Example

The digital inputs of the drive controller (direct or inverted), parameters with the BOOL data type or individual bits of
parameters with the BYTE, WORD or DWORD data type (example bit addressing: E49.4 for Switch on inhibit reason = STO)
can serve as the source for the signals for increasing and resetting the counter status. The reset signal has priority and is
executed immediately; as long as it is active, the counter reading remains at 0 and rising edges to increase the counter
reading are ignored.
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6.1.6.1.1 Parameterizing counters

To parameterize the additional counter function, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.
2. Select the Drive Based Center Winder application wizard > Additional functions.
3. Activate the Counter option.
= The additional function is activated and the associated wizards and parameters are displayed.
4. Select the Drive Based Center Winder application wizard > Additional functions > Counters.
5. Number:
Select the desired counter and activate it using the corresponding option.
= The associated parameters are displayed.
6. N41 Counter comparison value:
Define the comparison value.
7. N43 Source counter:
Select the source for the signal that increases the counter reading by 1 until the comparison value is reached.
7.1. If a parameter is the source, select 2: Parameter.
7.2. If adigital input (direct or inverted) acts as the source, select the corresponding input.
8. N45 Counter indirect reading:
If a parameter is used as the source for increasing the counter, define the desired coordinate, if necessary with bit
addressing.
9. N46 Source reset counter reading:
Select the source for the signal that resets the counter reading to 0.
9.1. If a parameter is the source, select 2: Parameter.
9.2. |If adigital input (direct or inverted) acts as the source, select the corresponding input.
10. N47 Reset counter reading via parameter:
If a parameter is used as the source for resetting the counter, define the desired coordinate, if necessary with bit
addressing.
6.1.6.1.2 Parameterizing counters: Examples

For example, you can use the additional counter function to control the digital outputs directly by reaching the comparison

value.

Controlling a digital output directly

To control a digital output directly via the counter, you can use the status of the counter as a source.

=

Activate the additional counter function.

Select the Counters wizard.

Parameterize the counter according to your application case.

Select the status of the counter as the source for the desired digital output (e.g. DO1: F61 = N42).

The digital output is controlled directly via the status of the counter.
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6.1.6.2 Additional motor potentiometer function

In Drive Based Center Winder type applications, the additional motor potentiometer (MOP) function provides you with the
option of adjusting an electromechanical potentiometer, such as for set value specification or for indirect control of the
digital outputs.

Function

The motor potentiometer can be adjusted continuously via digital up and down signals, for example for specifying set
values for axis movements via the output value (output value: G373). The output value can be limited by a maximum
positive and a maximum negative value (limit: G362, G363; limit value reached: G374). Either the digital inputs of the drive
controller or the graphical programming can serve as the source for the up and down signals (source: G364, G365). The
initialization signal has priority over the up and down signals and is executed immediately; the initialization value is freely
definable (source: G369; value: G366).

Signals Signals
A A

Fig. 19: Motor potentiometer: Linear and stepwise calculation

You can use the operating mode of the motor potentiometer to influence both the calculation of the output value and the
storage behavior (operating mode: G368). The output value is calculated either linearly or in steps and can be saved either
with an active enable signal, prior to the next restart of the drive controller or in non-volatile memory. The parameterized
ramp (ramp: G361) applies to both the linear and stepwise calculations. With a linear calculation, the output value is
changed for the duration of the incoming up or down signal. With a stepwise calculation, the output value is changed by the
parameterized increment at signal input (increment: G367). If another up or down signal is received while the set value has
not yet been reached, it is adjusted by the corresponding increment. If the up and down signals are active at the same time,
the output value remains unchanged in both operating modes.
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6.1.6.2.1

Parameterizing motor potentiometers

To parameterize the additional motor potentiometer function, proceed as described below.

1.

10.

11.

6.1.6.2.2

Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >

Wizard area.

Select the Drive Based Center Winder application wizard > Additional functions.

Activate the Motor potentiometer option.

= The additional function is activated and the associated wizards and parameters are displayed.

Select the Drive Based Center Winder application wizard > Additional functions > Motor potentiometer.

G361 Motor potentiometer ramp:

Define the ramp for calculating the output value.

G362 Motor potentiometer positive maximum value, G363 Motor potentiometer negative maximum value:

Define the maximum permissible positive and negative output values of the motor potentiometer.

G364 Source motor potentiometer up, G365 Source motor potentiometer down:

Select the sources for the up and down signals of the motor potentiometer.

7.1.

7.2.

If the graphical programming is used as the source, select 2: Parameter.

If a digital input (direct or inverted) acts as the source, select the corresponding input.

G368 Motor potentiometer operating mode:

Select the desired operating mode for the motor potentiometer.

8.1.

8.2.

To calculate the output value of the motor potentiometer linearly, select O: Linear, 2: Linear (remanent) or

4: Linear (enable-dependent), depending on the desired storage behavior.

To calculate the output value of the motor potentiometer in steps, select 1: Step-by-step, 3: Step-by-step

(remanent) or 5: Step-by-step (enable-dependent), depending on the desired storage behavior.

G367 Motor potentiometer increment:

If you calculate the output value of the motor potentiometer in steps, define the desired increment.

G366 Motor potentiometer initialization value:

Optionally define the desired initialization value.

G369 Source motor potentiometer initialization:

Select the source for the initialization signal of the motor potentiometer.

Parameterizing motor potentiometers: Examples

For example, you can use the additional motor potentiometer function to specify set values for the velocity, velocity

override or torque/force and thus control the axis directly in local operation, e.g. during commissioning, if the controller

fails or if the machine has no controller at all. Using the motor potentiometer, you can also control the analog outputs

directly or the digital outputs indirectly (using the additional REAL32 comparator function).

In Drive Based Center Winder applications, you can use the motor potentiometer to control analog and digital outputs as
well as for set value specification in command operating mode if you are using 4: MC_MoveVelocity, 8: MC_MoveSpeed or

Information

9: MC_TorqueControl as the motion command. When using the 30: MC_Winder motion command, the set value
specification for the set material velocity L405 or for the associated override LO7 is not provided using the motor

potentiometer.
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Specifying a set velocity (external velocity)

To specify a set velocity via the motor potentiometer, select its output value as the source for the external velocity and use

this as the set value source for the motion command.

1.

2.

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the External velocity: Data source wizard.

G461 Source external velocity:
Select 5: Indirect read parameter G811.

G811 Indirect read external velocity:
Select the output value of the motor potentiometer G373 as the source for the external velocity.

= The output value of the motor potentiometer serves as the source for the external velocity.

= The external velocity can be provided as a set value specification by accessing parameter G462.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J52.

7.1. 140 Command:

Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.
7.2. )52 Source velocity 1:

Select 1: Parameter G462 as the source for the external velocity.

The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is
carried out using maximum permissible speed 110.

Specifying a set velocity (external additional velocity)

To additionally regulate the set velocity via the motor potentiometer, select its output value as the source for the external

additional velocity and use this as the set value source for the motion command.

v" You are using command operating mode or velocity, torque/force operating mode.

1.

2.

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the External additional velocity: Data source wizard.

G464 Source external additional velocity:

Select 5: Indirect read parameter G811.

G812 Indirect read additional external velocity:
Select the output value of the motor potentiometer G373 as the source for the external additional velocity.
= The output value of the motor potentiometer serves as the source for the external additional velocity.

= The external velocity can be provided as a set value specification by accessing parameter G465.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
154.

7.1. )40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.
7.2. )54 Source velocity 2:

Select 1: Parameter G465 as the source for the external additional velocity.

The output value of the motor potentiometer serves as the set value specification; the conversion to a set velocity is
carried out using maximum permissible speed 110.
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Specifying the velocity override

To specify a velocity override via the motor potentiometer, select its output value as the set value source and apply the

velocity override to the motion command.

1.

2.

=

Activate the additional motor potentiometer function.

Select the Motor potentiometer wizard.

Parameterize the motor potentiometer according to your application case.
Select the Velocity override: Data source wizard.

G467 Source velocity override:

Select 5: Indirect read parameter G813.

G813 Indirect read velocity override:
Select the output value of the motor potentiometer G373 as the source for the velocity override.
= The output value of the motor potentiometer serves as the source for the velocity override.

= The velocity override can be provided as a set value specification by accessing parameter G468.

For the command operating mode, parameterize the motion command and set value source via parameters J40 and
J51.

7.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. )51 Source velocity override:

Select 1: Parameter G468 as the source for the velocity override.

The output value of the motor potentiometer is used as the set value specification for the velocity override.

Specifying the set torque/set force

To specify a set torque/force via the motor potentiometer, select its output value as the set value source for the motion

command.
1. Activate the additional motor potentiometer function.
2. Select the Motor potentiometer wizard.
3. Parameterize the motor potentiometer according to your application case.
4. Select the Set torque/force, velocity bracketing: Data source wizard.
5. G470 Source torque/force reference:
Select 5: Indirect read parameter G814.
6. G814 Indirect read torque/force reference:
Select the output value of the motor potentiometer G373 as the source for the set torque/force.
= The output value of the motor potentiometer serves as the source for the set torque/force.
= The set torque/force can be provided as a set value specification by accessing parameter G471.
7. For the command operating mode, parameterize the motion command and set value source via parameter J40.
7.1. 140 Command:
Select the 9: MC_TorqueControl motion command.
= The parameterized set value source is applied automatically; no further settings are necessary.
= The output value of the motor potentiometer serves as the set value specification for the set torque/force.

89



6 | More on Drive Based Center Winder? STOBER

6.2 Center winder — Concept

A system that allows winding, unwinding or rewinding of materials such as plastic, wire, textiles or paper is called a winder.
There are various winding processes for implementing winding applications. In the center winder, the winding is driven by a
central shaft with an attached winder case onto which material is wound or from which material is unwound.

Surface winder Center winder (surface winder)  Center winder (gap winder)

Fig. 20: Center winder: Types

When material is wound or unwound, the diameter of the winding changes. The winding diameter must be measured by a
sensor or calculated by the drive in order to keep the material tensile force, material velocity or dancer position constant. If
a sensor is not used, the drive controller calculates the winding diameter from the material velocity. The motion variables
which are relevant depend on the selected winding method (open-loop or closed-loop control process) of the center
winder.
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6.2.1 Winding methods

The winding method is the open-loop or closed-loop control process of the center winder that influences the calculation of the main set values, of which the winding diameter is of central

importance. Depending on the winding method, it may be necessary to parameterize different motion variables and possibly the PID controller.

Velocity control (open Velocity control Tensile force control Tensile force control Tensile force control
loop) (open loop) (closed loop) with (closed loop) with
torque correction velocity correction

Diameter v v

Set material velocity v v v v v

Actual material velocity (V) v (V) (V) (v)

Set material tensile force — - v v v

Actual material tensile - - - v v

force

Dancer position - - - - -

PID controller - v - v v

(v'): Required if L20 = 0: Diameter calculator

Tab. 4: Winding methods: Required motion variables

Depending on the objective of your application, the following winding methods are available in the Drive Based Center Winder application.

Dancer position control
with velocity correction
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6.2.1.1 Velocity control (open loop), velocity control (closed loop)

With open-loop and closed-loop velocity control of the center winder, the set material velocity is specified as the main
motion variable. The actual material velocity must be known for closed-loop velocity control, while open-loop velocity
control can also be used without additional measuring systems such as sensors.

These two winding methods are particularly suitable for simple applications where the material velocity is more important
than the accuracy of the material tensile force or a uniform winding result (e.g. winding crane rope).

Velocity control (open loop)

.W

= ©

['o

Center winder

Fig. 21: Structure: Center winder with open-loop velocity control

With open-loop velocity control, the axis follows the specified set material velocity; parameterization of the PID controller is
generally not required. Parameterization of the actual material velocity is only necessary if the winding diameter is
calculated instead of measured.

If the actual material velocity must be known for the calculation of the winding diameter, closed-loop velocity control can
also be used instead of open-loop velocity control and the PID controller can be parameterized to achieve a more uniform
winding result.

Velocity control (closed loop)

&
- ® 0

Material velocity
sensor

.N

['o

Center winder

Fig. 22: Structure: Center winder with closed-loop velocity control

With closed-loop velocity control, the actual material velocity is adjusted to the specified set material velocity by correcting
the set velocity of the motor using the manipulated variable of the PID controller.

The material velocities are scaled using L358 at the input of the PID controller (units: mm/s > %) before they are written to
the set value L360 and actual value L361 of the PID controller. The manipulated variable L366 of the PID controller is scaled
using L358 (unit: % > mm/s) before it is added to the set material velocity.

92

03/2025 | ID 443440.03



03/2025 | ID 443440.03

STOBER

6 | More on Drive Based Center Winder?

Set velocity

The set velocity L102 of the axis is calculated using the specified set material velocity L420 and winding diameter L29 and
filtered using the time constant in L104. With closed-loop velocity control, the PID controller manipulated variable L366 is
also taken into account when calculating L102.

Set torque

The set torque L103 of the axis is used for the torque feedforward control of the center winder in order to compensate for
the friction and mass moment of inertia of the axis. The maximum permitted set torque is not defined by the application
(D232, D233), but by the axis model (C03, CO5).

6.21.2 Tensile force control (open loop), tensile force control (closed loop)

For open-loop and closed-loop tensile force control of the center winder, the set material tensile force and set material
velocity are specified as the main motion variables. The actual material tensile force must be known for closed-loop tensile
force control, while open-loop tensile force control can also be used without additional measuring systems such as sensors.

These winding methods are particularly suitable for applications where velocity is not important, but the material tensile
force or a uniform winding result is (e.g. winding foil). Only the actual material tensile force needs to be known for closed-
loop tensile force control, whereas open-loop tensile force control can also be used without additional measuring systems
such as sensors.

With both open-loop and closed-loop tensile force control, the material tensile force can also be modified, such as with the
aid of a diameter-dependent override (winding hardness curve).

Tensile force control (open loop)

.N

= ©)

[0

Center winder

Fig. 23: Structure: Center winder with open-loop tensile force control

With open-loop tensile force control of the center winder, the axis follows the specified set material tensile force;
parameterization of the PID controller is generally not required. Parameterization of the actual material velocity is only
necessary if the winding diameter is calculated instead of measured.

In order to achieve a uniform winding result, it is also essential to compensate for the static and dynamic friction of the axis
(L310). Compensation for the constant and variable mass inertia of the axis is optional (L300).
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Tensile force control (closed loop)

.N

- ™

[0

Material tensile force
sensor

Center winder

Fig. 24: Structure: Center winder with closed-loop tensile force control

With closed-loop tensile force control of the center winder, the actual material tensile force is adjusted to the specified set
material tensile force. To adjust the actual material tensile force to the set material tensile force, the closed-loop control
corrects either the set torque of the axis (torque correction) or set velocity of the axis (velocity correction).

With closed-loop tensile force control, the material tensile forces are scaled using L357 at the input of the PID controller
(units: N = %) before they are written to the set value L360 and actual value L361 of the PID controller. Depending on the
selected winding method, the manipulated variable L366 of the PID controller is scaled using L357 (unit: % - N) or L358
(unit: % > mm/s) before it is added to the set material tensile force (torque correction) or set material velocity (velocity
correction).

Set velocity

The set velocity L102 of the axis is calculated using the specified set material velocity L420 and winding diameter L29 and
filtered using the time constant in L104. For closed-loop tensile force control with velocity correction, the PID controller
manipulated variable L366 is also taken into account when calculating L102.

For both open-loop and closed-loop tensile force control with torque correction, the set material velocity L420 must be
increased with the aid of a velocity override LO7 to create a difference between the actual and set velocities so that the axis
remains in closed-loop tensile force control.

Set torque

For both open-loop and closed-loop tensile force control with torque correction, the set torque L103 of the axis is
calculated using the specified set material tensile force L510 and winding diameter L29 and filtered using the time constant
in L495. For closed-loop tensile force control with torque correction, the PID controller manipulated variable L366 is also
taken into account when calculating L103.

For open-loop tensile force control, the compensation for friction and mass inertia L300 and L310 is essential for a uniform
winding result; for closed-loop tensile force control with torque correction, the compensation primarily serves to relieve the
PID controller. In both winding methods, the maximum permitted set torque is defined by the application (D232, D233).

For closed-loop tensile force control with velocity correction, the set torque L103 of the axis is only used for the torque
feedforward control of the center winder in order to compensate for the friction and mass moment of inertia of the axis.
The maximum permitted set torque is not defined by the application (D232, D233), but by the axis model (C03, C05).
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6.21.3 Dancer position control

For dancer position control of the center winder, the set dancer position and set material velocity are specified as the main
motion variables. The actual dancer position must be known for dancer position control.

This winding method is particularly suitable for applications where there is a dancer that ensures a constant material tensile

force and is held in the same position by the center winder. The actual dancer position is measured by an encoder or
potentiometer and set to the specified set dancer position using the PID controller.

Dancer position control

.W

©

['o

Center winder

Dancer

Fig. 25: Structure: Center winder with dancer position control
For dancer position control, the actual dancer position L96 is adjusted to the specified set dancer position L95 by correcting
the set velocity of the motor using the manipulated variable of the PID controller.

Dancer positions are scaled using L359 at the input of the PID controller (unit: mm = %) before they are written to the set
value L360 and actual value L361 of the PID controller. The manipulated variable L366 of the PID controller is scaled using
L358 (unit: % - mm/s) before it is added to the set material velocity for velocity correction.

Parameterization of the actual material velocity is only necessary if the winding diameter is calculated instead of measured.

Set velocity

The set velocity L102 of the axis is calculated using the specified set material velocity L420 and winding diameter L29 and
filtered using the time constant in L104. When calculating L102, the PID controller manipulated variable L366 is also taken
into account.

Set torque

The set torque L103 of the axis is used for the torque feedforward control of the center winder in order to compensate for
the friction and mass moment of inertia of the axis. The maximum permitted set torque is not defined by the application
(D232, D233), but by the axis model (C03, CO5).
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6.2.2 Motion variables

Depending on the application, the material velocity, material tensile force and, if applicable, dancer position are particularly
important for the parameterization of Drive Based Center Winder applications. The motion variables which are relevant for
your application depend on the selected winding method.

6.2.2.1 Material tensile force

The material tensile force is key for both open-loop and closed-loop tensile force control of the center winder (LOO =
1: Tensile force control (open loop), 2: Tensile force control, torque correction, 3: Tensile force control, velocity correction).

Material tensile force: Source

Depending on the drive controller series, an analog input or fieldbus can be used as the source for the set material tensile
force (source: L498). The set material tensile force is filtered with the time constant defined in L495 and the filtered value is
displayed in L499.

Depending on the drive controller series, an analog input or fieldbus can be used as the source for the actual material
tensile force for closed-loop tensile force control (source: L492). The measured actual material tensile force is filtered with
the time constant defined in L489 and the filtered value is displayed in L493.

If an analog input is used as the source for the actual material tensile force or set material tensile force, the values at the
analog input All — AlI3 are scaled using the maximum permitted set material tensile force L497: 0% at the analog input
corresponds to 0 N and 100% corresponds to L497.

Actual material tensile force: Calculation

For closed-loop tensile force control, the actual material tensile force must be measured and specified by an external
source; in all other winding methods, the actual material tensile force can be calculated as a purely informative display
value.

If no external source is defined (L492 = 0: O (zero)), the actual material tensile force is calculated from the torque of the
geared motor and the winding diameter (torque: E90; diameter: L29), taking into account the torques for the compensation
for the mass inertia and friction of the axis. The calculated actual material tensile force is filtered with a time constant of
100 ms and the filtered value is displayed in L481.

When calculating the actual material tensile force, the actual torque of the geared motor is scaled using the load-side
reference value C09 (unit: % - Nm) and then offset against the torques for the compensation for friction and mass inertia
of the axis depending on the direction of rotation (L310, L300). If the material is under tension, the result is a positive
torque value, which is converted into a linear actual material tensile force based on the current winding diameter.

Information

The actual material tensile force calculated by the drive controller only serves as a display value and is for information
purposes only. The calculated actual material tensile force cannot be used for closed-loop tensile force control.

Set material tensile force: Mode

The set material tensile force can be modified depending on the current winding diameter; selection is possible either
directly via DriveControlSuite or using the control word of the application via fieldbus (mode: L500; control word: L150, bit
5-6).
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6.2.2.2 Material velocity

The material velocity is important in all winding methods, as the set velocity of the axis is calculated based on the set
material velocity and winding diameter. The actual material velocity is required for closed-loop velocity control of the
center winder and, if necessary, for the calculation of the winding diameter (LOO = 5: Velocity control; L20 = 0: Diameter
calculator).

If L20 = 0: Diameter calculator, the actual material velocity must correspond to the actual velocity of the material directly at
the winder; as a result, the winding diameter, and consequently the set torque of the axis, can be calculated exactly for a
uniform winding result.

If LOO = 4: Dancer position control, velocity correction, for example, the actual material velocity before the dancer may
deviate from the actual material velocity after the dancer.

Material velocity: Source

Depending on the drive controller series, an analog input or fieldbus can serve as the source for the set material velocity
(source: L400). The set material velocity is filtered with the time constant defined in L406 and the filtered value is displayed
in L420. The sign of the set material velocity L420 defines the winding direction.

Depending on the drive controller series, the source for the actual material velocity can be an analog input, a fieldbus, the
set material velocity or the actual velocity of a master encoder (source: L452). The actual material velocity is filtered with
the time constant defined in L456 and the filtered value is displayed in L454.

If an analog input is used as the source for the actual material velocity or set material velocity, the values at analog input
All — Al3 are scaled using the maximum permitted material velocity L410: 0% at the analog input corresponds to 0 mm/s
and 100% corresponds to L410.

Inverting the actual material velocity

If LOO = 5: Velocity control, the actual material velocity L454 and set material velocity L452 must have the same sign, i.e.
both the set material velocity and actual material velocity must be positive when winding and both material velocities must
be negative when unwinding. The sign of the actual material velocity can be inverted using L458.

6.2.2.3 Dancer position

The dancer position is only important for dancer position control of the center winder (LOO = 4: Dancer position control,
velocity correction).

Dancer position: Source
The set dancer position can be specified directly via DriveControlSuite or via fieldbus (source: L95).

Depending on the drive controller series, an analog input or fieldbus can be used as the source for the actual dancer
position (source: L90). The actual dancer position is filtered with the time constant defined in L93 and the filtered value is
displayed in L94 or L96 depending on the selected source.

If an analog input is used as the source for the actual dancer position, the values at the analog input Al1 — Al3 are scaled
using the maximum permitted set dancer position L91[0] — [1] and L92[0] — [1] (unit: % - mm). In L91, the value range at
the analog input is defined that is to be converted from a voltage in % to a position in mm according to the defined value
range in L92.

If you want to use material tear monitoring, the general value range of the actual dancer position (L92[0] — L92[1]) must be
greater than the permitted value range of the set dancer position.
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6.2.3 Winding diameter

The winding diameter L29 is an essential part of the Drive Based Center Winder application, as the specified or determined
linear motion variables can only be converted into rotational motion variables via the diameter.

The source for the winding diameter can either be a sensor or the diameter calculator of the Drive Based Center Winder
application (source: L20).

Depending on the drive controller series, an analog input or fieldbus can serve as the source for the diameter sensor
(source: L21).

If the diameter calculator is used as the source, the winding diameter is calculated using the actual material velocity L454
and actual velocity of the motor 188.

The winding diameter is limited by the parameters LO3 and L04 to the minimum or maximum permitted winding diameter,
which usually corresponds to the empty winder case or full winding.

Diameter calculator: Continuing motion

In order to be able to calculate the winding diameter, the minimum permitted velocity LO2 of the diameter calculator must
not be undershot. For example, if the diameter falls below L02 due to stopping the axis or changing the winding direction
(winding €= unwinding), the diameter calculator outputs the minimum permitted winding diameter LO3.

When continuing winding, the diameter calculator may initially provide unstable values when it increases from the
minimum permitted winding diameter LO3 back to the actual diameter if the minimum permitted velocity L0O2 is exceeded.
To enable the correct calculation of the winding diameter when continuing motion from a standstill, you can either retain
the diameter or use a start diameter.

Retaining the diameter

If you retain the last correctly calculated winding diameter before stopping the axis, you can use it after continuing motion
from a standstill and when using the diameter calculator temporarily for a more even winding result. This requires that the
diameter is not significantly changed manually while the axis is at a standstill, e.g. by replacing the winding with an empty
winder case.

Depending on the drive controller series, a digital input or fieldbus can serve as the source for the function for retaining the
diameter (source: L28).

Start diameter

You can use the start diameter L31 to specify a suitable winding diameter for the axis at the start of the motion, e.g. after
starting the application or when continuing motion from a standstill, even if the full winding has been replaced by an empty
winder case in the meantime or vice versa.

The start diameter is particularly important when unwinding with the diameter calculator, as otherwise the minimum
permitted winding diameter LO3 will be used at the start of the motion until the minimum permitted velocity LO2 of the
diameter calculator is exceeded.

Depending on the drive controller series, a digital input or fieldbus can be used as the source for activating the start
diameter (source: L30).
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Diameter change limit

The diameter change limit can be set either via the digital inputs of the drive controller, via DriveControlSuite itself or using
the control word of the application via fieldbus (source: L35; control word: L150, bit 3).

Limiting the diameter change optimizes the winding result by only allowing the winding diameter to change in the winding
direction, i.e. the diameter may only increase when winding and only decrease when unwinding. Instead of changing the
diameter in the incorrect direction, the diameter is retained. For example, diameter changes against the winding direction
can occur due to measurement errors when recording the actual values for the diameter calculator or diameter sensor
(source: L20).

To reduce diameter jumps when winding or unwinding in the permitted winding direction, a maximum permitted change in
winding diameter per second can also be defined (maximum diameter change: L36).

The diameter change limit can be paused for the duration of the Enable-off, e.g. in order to replace a full winder with an
empty winder case (or vice versa) during Enable-off, without having to manually deactivate and then reactivate the
diameter change limit (parameter: L37). The diameter change limit is automatically continued with the current winding
diameter with the subsequent Enable-on.

If the winding direction changes (L420 change of sign), the start diameter is activated (L30 # O: Inactive) or the diameter
change limit is deactivated (L35 = O: Inactive), the L29 corrections to the winding diameter are automatically reset.
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6.2.4 Winding direction

The winding direction is determined by the sign of the set material velocity L420. If the set material velocity is positive, the
center winder winds up (increasing winding diameter); if the set material velocity is negative, it unwinds (decreasing
winding diameter).

The polarity of the center winder L10 defines the direction of interpretation between the winding direction and motor
movement, i.e. the relationship between the signs of the set material velocity L420 and set velocity of the motor L102.

DriveControlSuite takes both the winding direction and center winder polarity into account when visualizing the selected
winding method (wizard: Center winder).

©

00
N2

Center winder

Fig. 26: Center winder: Positive winding (winding from above)

Winding direction L420 = positive Winding
Center winder polarity L10 = 0: Positive The signs of the set velocities are the same (L102 = positive)
=

= ©

7

Center winder

Fig. 27: Center winder: Negative winding (winding from below)

Winding direction L420 = positive Winding

Center winder polarity L10 = 1: Negative The signs of the set velocities are inverted (L102 = negative)
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N

[/

Center winder

Fig. 28: Center winder: Positive unwinding

Winding direction L420 = negative Unwinding
Center winder polarity L10 = 0: Positive The signs of the set velocities are the same (L102 =
negative)

Center winder

Fig. 29: Center winder: Negative unwinding

Winding direction L420 = negative Unwinding

Center winder polarity L10 = 1: Negative The signs of the set velocities are inverted (L102 = positive)
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6.2.5 Compensation for friction and mass inertia

If LOO = 1: Tensile force control (open loop), to enable a uniform winding result, the static and dynamic friction of the axis
must be determined and compensated for. Friction compensation is optional for all other winding methods. If LOO =

2: Tensile force control, torque correction, compensation for the friction can relieve the PID controller. Compensation for
constant and variable mass inertia is optional for all winding methods and enables constant material tensile force when the
axis is accelerated.

To compensate for the friction and mass inertia of the axis, proceed as described in Compensating for friction and mass

inertia [» 45].

Static and dynamic frictional torque
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Fig. 30: Center winder: frictional torque of the axis

The frictional torque M; corresponds to the torque that the drive must provide to compensate for the friction of the axis.
The static frictional torque Mg,,,, must be provided by the drive in order to set the axis in motion from a standstill. The
dynamic frictional torque Mg,,, must be provided by the drive in order to keep the axis in motion (static frictional torque:
L110; dynamic frictional torque: L120).

Constant and variable mass moment of inertia

L200

Fig. 31: Center winder: mass moment of inertia of the axis
The mass moment of inertia J and the angular acceleration a result in the torque that the drive must provide to set the axis
in rotary motion.

The constant mass moment of inertia results from the sum of the mass moments of inertia of the motor, gearbox and shaft
with winder case (motor: B62; gearbox: L200; shaft + winder case: L220).

The variable mass moment of inertia results from the mass moment of inertia of the material depending on the current
winding diameter (winding: L240; diameter source: L20).

The mass moment of inertia of the axis results from the constant and variable mass moments of inertia (display: L320).
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6.2.6 Material tear monitoring

The Drive Based Center Winder application allows you to monitor the material for tearing or loosening using a sensor, an
algorithm or a combination of both (source: L381). If a material tear or looseness is detected, the corresponding bit is set in
the status word of the application (signal: L904; status word: L155, bit 7). If a material tear is detected, application event O
may also be triggered, which can be evaluated either as a message, warning or fault (level: U100).

The algorithm detects a material tear under the following conditions (prerequisite: L381 = 2: Algorithm, 3: Algorithm +
sensor):

Winding method Condition for L904 = 1: Active

0: Velocity control (open loop), 5: Velocity control -

1: Tensile force control (open loop) Deviation > 5% between actual torque and set torque of the
axis (E90, L103) and motion profile of the motion core has
reached the set velocity (1183 = 1: Active)

2: Tensile force control, torque correction, 3: Tensile force  Actual material tensile force is less than the minimum
control, velocity correction permitted material tensile force (L493 < L382)

4: Dancer position control, velocity correction Actual dancer position is less than minimum permitted
dancer position (L96 < L97)

Tab. 5: Material tear monitoring: Algorithm

To parameterize the material tear monitoring, proceed as described in Parameterizing material tear monitoring [» 56].

6.2.7 PID controller

In the Drive Based Center Winder application, the PID controller is available both in center winder operating mode and in
command mode for the following winding methods (prerequisite: J50 = 30: MC_Winder).

= 2:Tensile force control, torque correction

= 3:Tensile force control, velocity correction

= 4: Dancer position control, velocity correction
= 5:Velocity control

To enable the PID controller in the Drive Based Center Winder application, the drive controller must be enabled and the
30: MC_Winder motion command must be selected. For example, the PID controller can be enabled via the digital inputs or
via the control word of the center winder; the enable status is displayed in the status word of the center winder (source:
L370; control word: L150, bit 8; status word: L155, bit 8).

PID controller: Scaling, limit

To calculate the manipulated variable, the material tensile force, material velocity and dancer position are scaled at the
input of the PID controller (parameters: L357, L358, L359; units: N > %, mm/s > %, mm = %). At the output of the PID
controller, the manipulated variable is scaled into the target unit (units: % - N, % - mm/s) to correct the set torque L103
or set velocity L102 of the axis.

A maximum permitted positive and negative manipulated variable can be specified for the PID controller (limit: L355, L356).
Whether the manipulated variable, and therefore also the integral share, of the PID controller is currently limited is
displayed in parameter L365.

103



6 | More on Drive Based Center Winder? STOBER

PID controller: Inputs
The following parameters are important at the input of the PID controller:
= Control difference L362
= Loop gain K, L350
= Proportional coefficient K, L351
= Integral coefficient K, L352
= Derivation time T, L353

The control difference is the difference between the set value and actual value of the PID controller (set value: L360; actual
value: L361). The PID controller uses the control difference for corrective measures to adjust the actual values to the set
values.

The loop gain K, controls the response speed and stability of the control loop. The loop gain influences how precisely and
quickly the PID controller responds to changes in the actual material tensile force or actual dancer position. The correct
setting is crucial to avoid vibrations and achieve an even winding result.

The proportional coefficient K, controls the direct response of the PID controller to control differences. A higher
proportional coefficient increases the correction of the control difference, while a lower proportional coefficient leads to a
smoother response. The correct setting is crucial for stable and efficient control of the system.

The integral coefficient K, accumulates deviations between the set value and actual value over time and corrects long-term
deviations. A higher integral coefficient leads to faster compensation of long-term errors, but can lead to instability due to
overshooting if it is set too high. A lower integral coefficient responds more slowly to errors and can lead to more sluggish
control. The correct setting ensures that long-term deviations between the set and actual values are effectively corrected.

The derivation time T, responds to the rate of change of the deviation between the set and actual values. A higher
derivation time improves the response to rapid changes. A lower derivation time leads to smoother control, but responds
more slowly to rapid changes. The correct setting is crucial for stability and avoiding unwanted noise.

PID controller: Outputs

The following parameters are important at the output of the PID controller:
= Manipulated variable y L366
= Proportional share (P-share) L363
= |Integral share (I-share) L364

Depending on the control process of the center winder, the manipulated variable y acts on the set velocity or set torque of
the motor. The manipulated variable is offset against the actual set value in order to compensate for the control difference.

To correct the set velocity, the sum of the manipulated variable and linear set material velocity is converted into a
rotational set velocity based on the winding diameter, which is adjusted for the direction of rotation and displayed as the
set velocity of the motor in L102 filtered with L104.

To correct the set torque, the sum of the manipulated variable and linear set material tensile force is converted to a
rotational set torque based on the winding diameter, which is then added to the torques for compensating for the friction
and mass inertia of the axis and displayed as the set torque of the motor in L103 scaled with C09.

The proportional share results from the loop gain K,, proportional coefficient K, and control difference e (K,: L350; K;: L351;
e: L362).

The integral share results from the loop gain K, integral coefficient K, and integrated control difference e (K,: L350, K;: L352;
e: 1362).
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6.3 Axis model

With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

As a rule, there are rotational or translational axis models with an endless (modulo) or limited travel range. In Drive Based
Center Winder applications, 105 Type of axis and 100 Position range are preset to a rotational axis model with an endless
travel range and the axis is scaled using the predefined unit of measurement °. You parameterize the encoder arrangement
by using B26 Motor encoder and 102 Position encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° of real axis movement). The scaling of the axis model is
calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

M Motor
MEnc Motor Encoder
PEnc Position Encoder

Rotational axis model

The following figures show an endless rotational axis model consisting of a motor, gearbox and rotary table. Rotational axis

N

models support rotational motor encoders as well as rotational position encoders.

ny
= M,

Gear

Fig. 32: Endless-rotational motion: Rotary table

Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and 102 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gearbox output. If
you use only one of the two encoders, it will be used for both velocity and position control.
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Encoder Parameterization Encoder arrangement

Motor encoder B26 # 0: Inactive ®:®:
102 = 0: Motor encoder n.

MEnc  Gear unit

Position encoder B26 # 0: Inactive @: n,
102 = B26 "2 ( )

Gear unit  PEnc

Motor encoder & position B26 # 0: Inactive ®:®: n, ( )
encoder 102 % B26 n,

MEnc  Gear unit PEnc
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6.4 Limit switches

Limit switches are sensors that detect when a certain position has been reached.

A distinction is made here between hardware limit switches and software limit switches. While a hardware limit switch is a
real switch (hardware), a software limit switch refers to the position limiting or position monitoring implemented in the
software.

Software limit switches are only available with a limited travel range (100 = 0: Limited) and are therefore not available in
Drive Based Center Winder applications, as the axis model is preset as fixed endless rotational.

Behavior in jog mode, reaching the +/- 31 bit computing limit and simultaneous triggering of positive and negative limit
switches are special cases.

6.4.1 Real axes

6.4.1.1 Faults

If a hardware limit switch is crossed, a fault is triggered immediately (signal: 1441, 1442).

Fault

53: Limit switch

Causes
= 1: Hardware-Limit-Switch positive
= 2:Hardware-Limit-Switch negative
= 5:+/- 31 bit computing limit reached
= 7:Both limit switches not connected

The fault can be acknowledged. When the respective limit switch is crossed, a direction lock is triggered so that it is only
possible to move back from the limit switch in the opposite direction of motion (direction lock: 1196). Once the direction
lock is no longer active, the fault can be triggered again.

6.4.1.2 Denial

If a limit switch is crossed, a direction lock is triggered and movement of the axis in the locked direction is denied (direction
lock: 1196).

With hardware limit switches, the direction lock is deactivated as soon as the axis has moved back from the limit switch, i.e.
as soon as the signal is no longer active (signal: 1441, 1442).

If the direction lock is active, parameter 191 Error = 1: Active and the cause is displayed in parameter 190.

Causes
= 1: lllegal direction
= 11: HW-limit switch positive
= 12: HW-limit switch negative
A limitation of the direction of motion is also displayed in parameter E80:

= E80 = 20: Limit switch:
Check the parameterization and the connection of the limit switches.

= E80 = 15: lllegal direction:
Check the set values and a possible direction lock in parameter 1196.

Also check 1196 if the permitted direction was limited with 104.
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6.41.3 Hardware limit switches

Hardware limit switches apply if your sources are defined in parameters 1101 and 1102.

Relevant parameters

If 1441 and 1442 = 0: Inactive, fault 53 is triggered with cause 7: Both limit switches not connected. Therefore, after
parameterizing 1101 and 1102, check whether the hardware limit switches are also connected physically.

1101 Source positive /limit switch

1102 Source negative /limit switch

1441 Signal /HW limit switch positive

1442 Signal /HW limit switch negative

1805 Actual value HW-Limit switch positive
1806 Actual value HW-Limit switch negative
152 Delete limit switch memory

1196 Direction blocking

If 1101 and 1102 = 2: Parameter, the fault is triggered by the control word of the application (1210). In this case, check the

controller connection.
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Passable hardware limit switches

The hardware limit switches can be passed over. It is therefore possible to use an infinite cam as a hardware limit switch.
The limit switch is detected if the signal goes to 0: Inactive (parameters 1441 and 1442).

If the hardware limit switch is overshot, the position at which the limit switch was detected is saved. When resetting limit
switches, the axis must have reached or passed back over this saved position before the signal is valid again.

Axis reference system

: Negative : Positive :
-~ ' | |
1442 Neg. hardware limit switch | :
| i i
I I
1806 Neg. hardware limit switch memory | |
| | | .
I I
1441 : : Pos. hardware limit switch
i i |
I I
1805 : : Pos. hardware limit switch memory
1 3
- —_—
2 4
—_— -

Fig. 33: Hardware limit switch memory

Setting the memory (negative hardware limit switch) with rising edge
Resetting the memory (negative hardware limit switch) with falling edge

Setting the memory (positive hardware limit switch) with rising edge

A WN e

Resetting the memory (positive hardware limit switch) with falling edge

Information

The passable hardware limit switch is no longer effective once the position at which the edge of the limit switch was
detected has been passed over again.

Note that the positions are not saved in non-volatile memory. This means that if the axis is beyond a passable limit switch
after activation, it must first be reset to the regular travel range.

The entire system is simpler if you do not use any passable limit switches.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter 152. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using 1452 or by
restarting the drive controller.

During referencing, the hardware limit switches are not evaluated as limit switches. There are referencing methods in which
the hardware limit switches are used for referencing.

Example

A positive limit switch ranges from position 100 to 120.

When moving in the positive direction, it is detected at 100.

On the return journey, due to tolerances, it can be the case that the limit switch has already been left at 101.
Despite this, position 100 must be undershot in order to leave the effective limit switch.
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6.4.1.4 Hardware limit switches when referencing

Hardware limit switches assume a special position when referencing.

Limit switch as reference switch

The hardware limit switches can be used in place of a reference switch (130 = 2: Limit switch).

Change of direction

In other referencing types, a hardware limit switch signal leads to a change of direction. However, the signal only causes a
change if it matches the direction of travel.

If the detected hardware limit switch does not match the direction of travel (e.g. negative limit switch with positive
direction of travel), a fault is then triggered.

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.
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6.4.2 Special cases

A few special cases are described below.

6.4.2.1 Reaching the +/- 31 bit computing limit

Fault:
53: Limit switch

Cause:
5: +/- 31 bit computing limit reached

The computing limit can be reached if, for example, so many commands follow after each other for the moving axis that the
total distance to be traveled (including decimal places) adds up to over 23,

6.4.2.2 Simultaneous detection of positive and negative hardware limit switches

Fault:
53: Limit switch

Cause:
7: Both limit switches not connected

This fault is triggered if 1441 and 1442 are both 0: Inactive. Check whether the hardware limit switches are also connected
physically.

I1f 1101 and 1102 = 2: Parameter, the fault is triggered by the control word of the application (1210). In this case, check the
controller connection.

The fault can be acknowledged with 152.

6.4.2.3 Behavior upon controller start-up

Fault:
53: Limit switch

Cause:
7: Both limit switches not connected

If a controller is used as the source for the digital signals for evaluating the hardware limit switches and this is still in device
start-up while the drive controller and fieldbus communication are already active, fault 53: Limit switch is triggered and the
limit switch memory is set (1805, 1806 = 1: Active).

If the power unit has not yet been enabled since the supply voltage was switched on, the limit switch memory is
automatically reset as soon as the controller correctly transmits the signals for evaluating the hardware limit switches.
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6.5 Referencing

To be able to work with a system with absolute positions, the relation of a measured to an actual axis position must be
determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary. As a rule, this is either identified through a reference search or referencing setting. The associated
process is referred to as referencing.

Absolute movements can be performed only in a referenced state.
For relative movements, referencing is only required if the software limit switch function is used at the same time.

When replacing a drive controller, the reference can be transferred to the replacement drive controller via an SD card. The
information is also saved on the SD card if the action AOO Save values is executed for the referenced axis. For more
information on replacing a drive controller, refer to the manual for the respective drive controller.

6.5.1 Referencing methods

The following table shows an overview of the possible referencing methods.

S Switch

M/F Torque or force

Method Initial Zero pulse Feature
movement

A Negative Negative limit switch
B Negative Yes Negatively positioned reference switch
C Negative - Negative limit switch
D Negative - Negatively positioned reference switch
—> E Positive Yes Positive limit switch
I ' F Positive Yes Positively positioned reference switch
G Positive - Positive limit switch
H Positive - Positively positioned reference switch
— | Positive Yes Centrally positioned reference switch
H I J Positive - Centrally positioned reference switch
<+ K Negative Yes Centrally positioned reference switch
I H L Negative - Centrally positioned reference switch
I i I M Negative Yes Zero pulse
I i I N Positive Yes Zero pulse
I L I (e} - - Setting the reference
{/
M/F —> P Positive - Torque/force stop
I Q Positive Yes Torque/force stop
<+— M/F R Negative - Torque/force stop
I S Negative Yes Torque/force stop

Tab. 6: Referencing methods
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6.5.1.1 Referencing methods in detail

The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

ALT Alternative

LS Limit Switch

RS Reference Switch

P Zero Pulse
Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

128 Homing torque/force limit
129 Time homing torque/force limit
130 Referencing type

131 Referencing direction

132 Referencing speed fast

133 Referencing speed slow

134 Reference position

135 Referencing with zero pulse
139 Referencing acceleration

143 Move to reference position
144 Referencing jerk

153 Index search offset

1101 Source positive /limit switch
1102 Source negative /limit switch
1103 Source reference switch
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6.51.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS- LS+

/

1

Preparation

1. Activate referencing method A by setting the following parameters to the specified values:
130 to 2: Limit switch,
131 to 1: Negative,
135 to 1: Active.
2. 1102:
Enter the data source for the negative limit switch.
3. 132,133,139, 144, 134:
Define the set values necessary for referencing.
4. 153:
Define the start of the search for the zero pulse search
Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the negative limit switch and continues its run with velocity 133 until it reaches

the next zero pulse after leaving the limit switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.5.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.
i - I

ALT 1 /

N
Y

ALT 2

s e

zp —

RS

Preparation

1. Activate referencing method B by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to 1: Negative,
135 to 1: Active.

2. 1103:

Enter the data source for the reference switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

4. 153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive is positioned in front of the reference switch
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration [39.
5. If143is setto 1: Active, the drive is positioned at reference position 134.
v' Alternative 2: Drive stopped at reference switch
1. The drive starts in the positive direction with acceleration 139 and velocity 133.
2. It changes its direction upon reaching the reference switch and continues its run with velocity 132.

3.  When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133

until it reaches the zero pulse.
4. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
5. The drive comes to a standstill with deceleration 139.

6. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS- LS+

/

L/)

LS-

Preparation

1. Activate referencing method C by setting the following parameters to the specified values:
130 to 2: Limit switch,
131 to 1: Negative,
135 to 0: Inactive.

2. 1102:

Enter the data source for the negative limit switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity 133 until it leaves

the limit switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the limit switch.
4. The drive comes to a standstill with deceleration 139.

5. If143is setto 1: Active, the drive is positioned at reference position 134.
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6.511.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

ALT 2

RS

—

ALT 1

I
w—]
N |

N\ /

| Y
I

Preparation

1.

Activate referencing method D by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to 1: Negative,

135 to 0: Inactive.

1103:

Enter the data source for the reference switch.

132,133, 139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

v

1.

2.

Alternative 1: Drive is positioned in front of the reference switch
The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 2: Drive stopped at reference switch
The drive starts with acceleration 139 and velocity 133 in the positive direction until it leaves the reference switch.
It changes its direction upon leaving the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133

until it reaches the reference switch again.
The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

LS- LS+

-
/

Y

zp —!

LS+ ;

Preparation

1. Activate referencing method E by setting the following parameters to the specified values:
130 to 2: Limit switch,
131 to 0: Positive,
135 to 1: Active.

2. 1101:

Enter the data source for the positive limit switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

4. 153:

Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity 133 until it reaches

the next zero pulse after leaving the limit switch.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration [39.

5. If143is set to 1: Active, the drive is positioned at reference position 134.

03/2025 | ID 443440.03
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6.5.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

—

ALT 1 . >
[
! 1
P
ALT 2 .\ 0 —
b h
P
v
P L
i
RS I
Preparation
1. Activate referencing method F by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to O: Positive,
135 to 1: Active.
2. 1103:
Enter the data source for the reference switch.
3. 132,133,139, 144, 134:
Define the set values necessary for referencing.
4. 153:

Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

v" Alternative 1: Drive is positioned in front of the reference switch

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.

The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.

Alternative 2: Drive stopped at reference switch

The drive starts in the negative direction with acceleration 139 and velocity 133.

It changes its direction upon reaching the reference switch and continues its run with velocity 132.

When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133

until it reaches the zero pulse.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS- LS+

-
/

Y

{i/

LS+

Preparation

1. Activate referencing method G by setting the following parameters to the specified values:
130 to 2: Limit switch,
131 to O: Positive,
135 to O: Inactive.

2. 1101:
Enter the data source for the positive limit switch.

3. 132,133,139, 144, 134:
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity 133 until it leaves the

limit switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the limit switch.
4. The drive comes to a standstill with deceleration 139.

5. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.5.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

| ' - ]

ALT 1 i . >
AN |
ALT 2 4 A

|

RS

Preparation

1. Activate referencing method H by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to O: Positive,
135 to 0: Inactive.

2. 1103:
Enter the data source for the reference switch.

3. 132,133,139, 144, 134:

Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.
v' Alternative 1: Drive is positioned in front of the reference switch
1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
3. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
4. The drive comes to a standstill with deceleration I39.

5. If143is set to 1: Active, the drive is positioned at reference position 134.

v" Alternative 2: Drive stopped at reference switch
1. The drive starts with acceleration 139 and velocity 133 in the negative direction until it leaves the reference switch.
2. It changes its direction upon leaving the reference switch and continues its run with velocity 132.

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133

until it reaches the reference switch again.
4. The current actual position is set to the value of the reference position 134 upon reaching the reference switch.
5. The drive comes to a standstill with deceleration 139.

6. If 143 is set to 1: Active, the drive is positioned at reference position 134.

121



6 | More on Drive Based Center Winder? STOBER

6.5.1

Refer

1.9 Referencing method |

encing method | determines the reference using a run to the centered reference switch and zero pulse.
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Preparation

1. Activate referencing method | by setting the following parameters to the specified values:

130 to 1: Reference input,
131 to O: Positive,
135 to 1: Active.

1103:

Enter the data source for the reference switch.

132, 133, 139, 144, 134:

Define the set values necessary for referencing.

153:

Define the start of the search for the zero pulse search

Referencing

If the

v

1.

2.

PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

Alternative 1: Drive is positioned between the negative limit and reference switches
The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the

next zero pulse after leaving the reference switch.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration 139 and velocity 133.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 132.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration 139.

6. If 143 is set to 1: Active, the drive is positioned at reference position 134.

v Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the positive limit switch until the reference switch is reached.

3. Upon reaching the reference switch, the drive changes its velocity to 133 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position 134 after leaving the reference switch and upon
reaching the next zero pulse.

5. The drive comes to a standstill with deceleration 139.

6. If143is setto 1: Active, the drive is positioned at reference position 134.
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6.5.1

Refer

110 Referencing method )

encing method J determines the reference using a run to the centered reference switch.
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Preparation

1.

Activate referencing method J by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to O: Positive,

135 to 0: Inactive.

1103:
Enter the data source for the reference switch.

132,133,139, 144, 134:
Define the set values necessary for referencing.

Referencing

If the

v

1.

2.

PLCopen command MC_Home is active, a distinction is made between three referencing sequences.
Alternative 1: Drive is positioned between the negative limit and reference switches
The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration 139 and velocity 133.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 132 until it leaves the
reference switch.

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position 134 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration 139.

6. If143is set to 1: Active, the drive is positioned at reference position 134.

v" Alternative 3: Drive is positioned between the reference and positive limit switches

1. Thedrive starts in the positive direction with acceleration 139 and velocity 132.

2. Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the
reference switch.

3. Upon reaching the reference switch, the drive changes its velocity to 133 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration 139.

6. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.11 Referencing method K

Refer

encing method K determines the reference using a run to the centered reference switch and zero pulse.
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Preparation

1. Activate referencing method K by setting the following parameters to the specified values:
130 to 1: Reference input,
131 to 1: Negative,
135 to 1: Active.
2. 1103:
Enter the data source for the reference switch.
3. 132,133,139, 144, 134:
Define the set values necessary for referencing.
4. 153:
Define the start of the search for the zero pulse search
Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.
v' Alternative 1: Drive is positioned between the reference and positive limit switches
1. Thedrive starts in the negative direction with acceleration 139 and velocity 132.
2. It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it reaches the
next zero pulse after leaving the reference switch.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The drive comes to a standstill with deceleration 139.
5. If143is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration 139 and velocity 133.

2. It changes its direction upon reaching the reference switch and continues its run with velocity 132.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity 133
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration 139.

6. If 143 is set to 1: Active, the drive is positioned at reference position 134.

v' Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. Upon reaching the reference switch, the drive changes its velocity to 133 and continues its run until it reaches the next
zero pulse after leaving the reference switch.

4. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration 139.

6. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.
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Preparation

1.

Activate referencing method L by setting the following parameters to the specified values:
130 to 1: Reference input,

131 to 1: Negative,

135 to 0: Inactive.

1103:
Enter the data source for the reference switch.

132,133,139, 144, 134:
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

v' Alternative 1: Drive is positioned between the reference and positive limit switches

1.

2.

The drive starts in the negative direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the reference switch and continues its run with velocity 133 until it leaves the

reference switch again.
The current actual position is set to the value of the reference position 134 upon leaving the reference switch.
The drive comes to a standstill with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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v' Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration 139 and velocity 133 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity 132.

3.  When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity 133
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position 134 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration 139.

6. If 143 is set to 1: Active, the drive is positioned at reference position 134.

v' Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3.  When the reference switch is reached, the drive changes its velocity to 133 and continues its run until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position 134 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration 139.

6. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.13 Referencing method M

This method determines the reference using a run to the zero pulse.

N
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P

Preparation

1. Activate referencing method M by setting the following parameters to the specified values:
130 to 3: Zero pulse,
131 to 1: Negative,

2. 132,139, 144, 134:
Define the set values necessary for the referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration 139.

4. If143is set to 1: Active, the drive is positioned at reference position 134.

6.51.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

N

i
ZP |

Preparation

1. Activate referencing method N by setting the following parameters to the specified values:
130 to 3: Zero pulse,
131 to O: Positive,

2. 132,139, 144, 134:
Define the set values necessary for the referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration 139 and velocity 132.

2. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration 139.

4. If143is set to 1: Active, the drive is positioned at reference position 134.

130

03/2025 | ID 443440.03



03/2025 | ID 443440.03

STOBER

6 | More on Drive Based Center Winder?

6.5.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

- i

Preparation

1. 130:
Activate referencing method O by setting this parameter to 5: Define home.
2. 134:
Define the reference position.
Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position 134.

6.5.1.1.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

- J
/ |

Preparation

1.

Activate referencing method P by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,

131 to O: Positive,

135 to 0: Inactive.

132, 139, 144, 134:

Define the set values necessary for the referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1.

2.

The drive starts in the positive direction with acceleration 139 and velocity 132.

The current actual position is set to the value of the reference position 134 when the torque/force limit is reached and

the time stored in 129 has elapsed.
The set values are set to the value 0 with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.5.1

Refer

117 Referencing method Q

encing method Q determines the reference using a run with a torque/force stop and zero pulse.
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Preparation

1.

Activate referencing method Q by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,

131 to O: Positive,

135 to 1: Active.

132, 133, 139, 144, 134:

Define the set values necessary for referencing.

128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

153:

Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value

that is too small, an incorrect reference position may be applied.

Referencing

If the

1.

2.

PLCopen command MC_Home is active, referencing takes places as follows:
The drive starts in the positive direction with acceleration 139 and velocity 132.

It changes its direction upon reaching the torque/force stop and when the time stored in 129 has passed, and

continues its run with velocity 133 until it reaches the next zero pulse.
The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
The set values are set to the value 0 with deceleration 139.

If 143 is set to 1: Active, the drive is positioned at reference position 134.
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6.51.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

I - I
“ /

Preparation

1

1. Activate referencing method R by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,
131 to 1: Negative,
135 to 0: Inactive.

2. 132,133,139, 144, 134:
Define the set values necessary for referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected

value that is too small, an incorrect reference position may be applied.

Referencing
1. Thedrive starts in the negative direction with acceleration 139 and velocity 132.

2. The current actual position is set to the value of the reference position 134 when the torque/force stop is reached and

the time stored in 129 has elapsed.
3. The set values are set to the value 0 with deceleration 139.

4. If143is set to 1: Active, the drive is positioned at reference position 134.
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6.5.1.1.19 Referencing method S

Referencing method S determines the reference using a run with torque/force stop and zero pulse.

w
/

P '

1

Preparation

1. Activate referencing method S by setting the following parameters to the specified values:
130 to 4: Torque/force stopper,
131 to 1: Negative,
135 to 1: Active.

2. 132,133,139, 144, 134:

Define the set values necessary for referencing.

3. 128, 129:
Define the torque/force limit. If the actual torque for the time stored in 129 is above the limit defined in 128 for an

ongoing period, the torque/force limit is reached.

4. 153:

Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:
1. The drive starts in the negative direction with acceleration 139 and velocity 132.

2. It changes its direction upon reaching the torque/force stop and after the time stored in 129 has passed, and continues

its run with velocity 133 until it reaches the next zero pulse.
3. The current actual position is set to the value of reference position 134 upon reaching the zero pulse.
4. The set values are set to the value 0 with deceleration 139.

5. If143is setto 1: Active, the drive is positioned at reference position 134.

6.5.2 Reference position

Depending on the referencing type 130, the actual position 180 is replaced by the reference position 134 during the

referencing event.

6.5.3 Reference retaining

STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (146) are offered.
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6.5.4 Reference loss

Axis
In certain cases, an axis loses its reference and its state changes from 186 = 1: Active to 186 = 0: Inactive.
Normal operation (axis)

During normal operation, encoder faults or actions can lead to a loss of the reference. If the reference was deleted by an
encoder event, it can subsequently be restored.

Information

Before restoring the reference, check the actual position displayed (180). If in doubt, do the referencing again. If relative
encoders are used or if the axis was still moving during the encoder fault, the actual position displayed may deviate from
the real actual position of the axis.

Event 76: Position encoder Encoder fault Actual position may still be correct, restoring
the reference is possible:

= Check the actual position (180).
= Confirm reference (1130) or re-reference
axis

Event 37: Motor encoder Encoder fault When using the motor encoder as a position
encoder (102 = 0: Motor encoder), 2 faults are
triggered (37: Motor encoder and 76: Position
encoder); in display parameter E82 and in the
fault memory it is possible that only one fault is
displayed.

Actual position may still be correct, restoring
the reference is possible:

= Check the actual position (180).

= Confirm reference (1130) or re-reference
axis
Action 138 Deleted reference Action 138 deletes the reference but does not
change the actual position displayed.

Actual position may still be correct, restoring
the reference is not possible:

= Check the actual position (180).
= Reference the axis again

Tab. 7: Reference loss of the axis in normal operation
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Changing parameters (axis)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the

reference.
Changing parameters Changed axis model Actual position is undefined if one of the
following parameters was changed:
= B26 Motor encoder
= (C15 Gearrationl
= (16 Gear ratio n2
= (C17 Feed constant numerator
= (18 Feed constant denominator
= |00 Position range
= 101 Circular length
= |02 Position encoder
= 103 Axis polarity
= 105 Type of axis
= |07 Distance factor numerator position
= 108 Distance factor denominator position
It is not possible to restore the reference:
= Reference the axis again
Changing parameters Changed encoder interface Actual position is undefined if a parameter of

the H group was changed.
It is not possible to restore the reference:
= Reference the axis again

Tab. 8: Reference loss of the axis due to parameter changes

Restarting the drive controller (axis)

Depending on the encoder type and method for reference retaining (146), the reference of a previously referenced axis is
restored or deleted after a restart.

By default (146 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if the axis was
referenced with this encoder. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in 146. In addition to the preset, the following further options are
available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (148)

= Reference is retained regardless of the presence of an encoder
= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
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Special case of incorrect motor connection (axis)

If a motor is inadvertently connected to the incorrect axis or the incorrect drive controller, such as after a case of service,
the drive controller behaves as follows after it is switched on:

= The axis changes to the non-referenced state (186 = 0: Inactive)
= The actual position displayed is undefined

However, the information from the original motor and the associated reference data are stored in the drive controller.
After switching off the drive controller, connecting the correct motor and restarting the drive controller, the reference is
restored and the actual position is displayed correctly (prerequisites: multi-turn absolute encoder, referenced axis and
preset for reference retaining 146 = 0: Normal).

Master encoder
Actual positions of the master encoder are used in the Drive Based Synchronous application for synchronous operation.

In all applications except the Drive Based Center Winder application, the actual position of the master encoder can be used
to pass on the position of another encoder attached to the machine to the control system. The drive controller transfers the
position from the encoder interface to the respective fieldbus.

Master encoders behave in a similar way to position encoders. In certain cases, a master encoder loses its reference and its
state changes from G89 = 1: Active to G89 = 0: Inactive.

Normal operation (master encoder)

During normal operation, encoder faults can lead to a loss of the reference.

Event 77: Master encoder Encoder fault Actual position of the master encoder is
undefined, it is not possible to restore the
reference:

= Reference the master encoder again

Tab. 9: Reference loss of the master encoder in normal operation
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Changing parameters (master encoder)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Changing parameters Changed axis model Actual position of the master encoder is
undefined if one of the following parameters
was changed:

= G30 Position range master
= G40 Circular length master
= G47 Distance factor numerator master
= G48 Distance factor denominator master
= G104 Source master encoder
It is not possible to restore the reference:

= Reference the master encoder again

Changing parameters Changed encoder interface Actual position of the master encoder is
undefined if a parameter of the H group was
changed.

It is not possible to restore the reference:
= Reference the master encoder again

Tab. 10: Reference loss of the master encoder due to parameter changes

Restarting the drive controller (master encoder)

Depending on the encoder type and method for reference retaining (G35), the reference of a previously referenced master
encoder is restored or deleted after a restart.

By default (G35 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if this encoder was
used for referencing. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in G35. In addition to the preset, the following further options are
available:

= Reference is retained if the measuring range covers the entire travel range

= Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (148)

= Reference is retained regardless of the presence of an encoder
= Reference is retained regardless of the encoder type

= Reference is deleted when the drive controller is switched off
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6.6 Drive Based device control

Drive Based device control is based on DRIVECOM profile drive technology 21; this profile describes the control sequence of
a drive controller based on a device state machine. Each device state here represents a certain behavior that can be
changed only through defined events. These events are assigned to individual state transitions.

Some of the conditions and responses coupled with the state transitions can be influenced specific to the user. For
example, it is possible to define the end of a quick stop or enable delays in a way that is tailored to the respective
application case (see wizard Drive Based device control).

The following chapters describe the device states and the possible state transitions associated with them. You will also
learn whether certain actions are necessary on your part to reach the individual device states, what those actions are and
which user-specific factors you can parameterize yourself.

6.6.1 Drive Based device state machine

The device state machine describes the different device states of the drive controller along with the possible state changes.

oo 14 . .
—> Fault reaction active

io 15

Not ready to switch on Faults
1
®® 12 16
oo 13 Switch on disabled 10 ee
A
2 6@
e 11 °
Ready to switch on 9
3 5e
\ 4
Switched on
4
Operation enabled 8 Quick stop active

Fig. 34: Drive Based device state machine: device states and state changes

Priority levels are marked by dots. The more dots a state change has, the higher its priority. Accordingly, a state change
without any dots has the lowest priority.
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6.6.2 States, transitions and conditions

The states provided by Drive Based device control all have specific features. A state either transitions into another state
automatically or requires certain actions from the user. There are also transition conditions that you can parameterize to be
tailored to your application case using the Drive Based device control wizard.

Parameter E48 shows the current device state of a drive controller.

6.6.2.1 Key

The following terms are used in the descriptions of the states, transitions and conditions:

Enable active Additional enable signal is active (A300 = 1: Active, source: A60)
Enable is inactive Additional enable signal is inactive (A300 = 0: Inactive, source: A60)
Quick stop in case of Enable-off active Quick stop in case of Enable-off is active (A44 = 1: Active)

Quick stop in case of Enable-off inactive  Quick stop in case of Enable-off is inactive (A44 = 0: Inactive)

Quick stop end Standstill reached
OR
maximum quick stop duration has expired (A39)
OR
A45 =1: No stop AND quick stop request is inactive
Quick stop duration expired Maximum quick stop duration has expired (A39)
Autostart active Autostart is active (A34 = 1: Active)
Autostart inactive Autostart is inactive (A34 = 0: Inactive)

Tab. 11: States, transitions and conditions: Terms

6.6.2.2 Not ready to switch on

Features
= Drive controller and safety module are initialized and tested
= The power unit as well as drive and activation functions are locked

= Brakes remain engaged

Transition to Switch on disabled (1)

The drive controller switches to the Switch on disabled state automatically after initialization and successfully completing
the self-test (typically approx. 30 s).

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.6.2.3 Switch on disabled

Features
= |nitialization has been completed
= Self-test was successfully completed
= The power unit as well as drive and activation functions are locked
= Brakes remain engaged, release override can be requested with a rising edge
Possible causes of a switch-on lockout include:
1. Enableis active (A300) and Autostart is inactive (A34); cause only in the Switch on disabled state)
2. Insufficient or no supply voltage/DC link feed-in
3.  STO safety function is active

4.  Release override is active (source: FO6; cause only in the Switch on disabled, Ready to switch on and Switched on

states)

5.  Control panel or local operation is active (cause only in the Switch on disabled, Ready to switch on and Switched on

states)

For the exact cause of a switch-on lockout, refer to parameter E49.

Application-specific parameterization
A34 Auto start:

If this parameter is enabled, the drive controller switches directly to the Ready to switch on state in case of a pending
enable signal.

/A WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or machine in question permit a direct
switch to the Ready to switch on device state.

= In accordance with EN 61800-5-1, clearly mark an activated autostart on the system and in the associated system
documentation.

Transition to Ready to switch on (2)
Enable inactive AND no cause for a switch-on lockout
OR

Enable active AND Autostart active AND no cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.6.2.4 Ready to switch on

Features
= Power unit and drive function are disabled
= Drive controller is ready to switch on

= Brakes remain engaged, release override can be requested with a rising edge

Application-specific parameterization

In addition to the enable signal at terminal X1, the Drive Based device state machine also supports the use of an additional
enable signal, for example over a fieldbus or using digital inputs. The enable signal and additional enable signals are coupled
by an AND link. In this case, the drive controller is enabled only if the value of both signals is HIGH.

A60 Source additional enable:

If you are working with an additional enable signal, define the data source of the additional signal in this parameter. In the
case of a fieldbus connection, A180 bit 0 supplies the additional enable signal.

Transition to Switched on (3)

Enable active

Transition to Switch on disabled (6), priority: ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction

6.6.2.5 Switched on

Features
= Power unit is ready for operation
= Drive function is locked; set values are not processed

= Brakes remain engaged, release override can be requested with a rising edge

Transition to Operation enabled (4)

Enable active

Transition to Ready to switch on (5), priority: ®

Enable inactive

Transition to Switch on disabled (13), priority: ® ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.6.2.6 Operation enabled

Features

Power unit is switched on
Drive function is enabled, set values are processed

Brakes are released with the first active motion command

Application-specific parameterization

A43 Switch-off delay X1 enable:

If the enable signal at terminal X1 of a safety relay is affected by OSSD test pulses, the drive controller cannot
differentiate these signals from a functional enable-off. An incorrect interpretation of the test pulses can be avoided by
defining a delay time in this parameter that is greater than the duration of the test pulses. This then eliminates
unexpected switching of the drive controller to the states Ready to switch on or Quick stop active (see parameter A44).

A44 Quick stop at enable off:

This parameter results in a drive being stopped with a quick stop in case of an inactive enable. In this case, the drive
controller switches to the Quick stop active state. If parameter A44 is not activated, the drive switches to the Ready to
switch on state in case of Enable-off. In this case, the drive is brought to an uncontrolled standstill, the power unit is
disabled and axis movement is no longer controlled by the drive controller.

A29 Quick stop in case of fault

This parameter results in a drive being stopped with a quick stop in case of a fault. In this case, the drive controller
switches to the Quick stop active state. If parameter A29 is not activated, the drive switches to the Fault reaction active
state in the event of a fault. In this case, the drive is brought to an uncontrolled standstill, the power unit is disabled
and axis movement is no longer controlled by the drive controller.

Transition to Quick stop active (7)

Request for a quick stop

OR

Enable inactive AND quick stop in case of Enable-off active

OR

Request for drive-controlled SS1

OR

Request for drive-controlled SS2

Transition to Ready to switch on (11), priority: ®

Enable inactive AND quick stop in case of Enable-off inactive

Transition to Switch on disabled (12), priority: ® ®

Cause for a switch-on lockout

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.6.2.7 Quick stop active

Features
= Power unit is switched on; drive function is enabled

= A quick stop is executed

= Brakes remain released, brake engages at the end of the quick stop or at standstill

= Brake engaging ends the quick stop

Application-specific parameterization

= A39 Maximum quick stop duration for enable off:

If the drive is stopped with a quick stop in the case of an inactive enable signal (see A44), define the maximum time
after which the power unit is switched off in this parameter.

= A45 Quick stop end:

Define whether a quick stop is ended with a standstill of the drive or by canceling the quick stop request in this

parameter.

= A62 Source /quick stop:

Define how a requested quick stop is triggered in this parameter.

Transition to Operation enabled (8)
No quick stop request

AND

Enable active

AND

Quick stop end

AND

No SS1

AND

No SS2

Transition to Ready to switch on (9), priority: ®
Enable inactive AND quick stop in case of Enable-off inactive
OR

Enable inactive AND quick stop end

Transition to Switch on disabled (10), priority: ® ®
Cause for a switch-on lockout

OR

No SS1 AND no SS2 AND quick stop end

OR

SS1 AND standstill

Transition to Fault reaction active (14), priority: ® ® ®

Fault with or without fault reaction
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6.6.2.8 Fault reaction active

Features
= Adrive error has occurred
= Fault reaction is executed depending on the respective fault event

= Brakes are activated depending on the respective fault reaction

Application-specific parameterization
A29 Quick stop in case of fault:

If this parameter is activated, the drive is stopped with a quick stop, if possible, in case of fault; if the parameter is inactive,
the movement of the axis is no longer controlled by the drive controller.

Transition to Fault (15)

Fault reaction finished

6.6.2.9 Fault

Features
= Adrive error has occurred
= The fault reaction is finished
= The power unit as well as drive and activation functions are locked

= Brakes engage

Transition to Switch on disabled (16)

After remedying the fault cause and then acknowledging the fault message, the drive controller automatically switches to
Switch on disabled.
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6.7 Motion commands

The operating modes of the application feature special motion commands that are based on the PLCopen standard and are

supplemented by three manufacturer-specific motion commands (MC_DoNothing, MC_MoveSpeed and MC_Winder). Any

motion command — except MC_Stop — can be interrupted during execution. To be able to execute a motion command, the

following requirements must be met:

= Local and jog mode must not be activated

= A drive controller must not be in the Switch on disabled or Fault device state

0: MC_DoNothing
8: MC_MoveSpeed

4: MC_MoveVelocity

9: MC_TorqueControl

2: MC_MoveRelative

3: MC_MoveAdditive

1: MC_MoveAbsolute

6: MC_Home

Axis moves without end with Velocity
set velocity
(without position control)

Axis moves without end with Position
set velocity
(with position control)

Axis moves without end with Torque/force
set torque/force

Axis moves a relative Position
distance;

set position is relative to the

actual position at the start of

the command

Axis moves a relative Position
distance;

set position is relative to the

set position of the previous

motion command

Axis moves to an absolute Position
set position

(referencing necessary)

Axis is referenced Depending on the selected

referencing type

Velocity, override
Acceleration
Deceleration

Jerk

Velocity, override
Acceleration
Deceleration

Jerk

Torque/force

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk

Position

Velocity, override
Acceleration
Deceleration

Jerk

Velocity, override
Acceleration
Deceleration

Jerk

Torque/force
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11: MC_Halt Axis is stopped; Velocity
next command can be run
before standstill

5: MC_Stop Axis is brought to a Velocity
standstill;
next command can be
executed after standstill

30: MC_Winder Axis moves according to the  Velocity
control behavior of the
center winder (L0OO)

Tab. 12: Drive Based Center Winder: Available motion commands

Deceleration

Jerk

Deceleration

Jerk

Material velocity
Material tensile force
Acceleration
Deceleration

Jerk

For detailed information on the motion commands, refer to the associated manual (see Further information [» 152]).

147



6 | More on Drive Based Center Winder? STOBER

6.8 Electronic nameplate

STOBER synchronous servo motors are generally equipped with EnDat encoders that provide a special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and electronic
values of a motor.

When you operate a drive controller with a STOBER synchronous servo motor and an EnDat encoder, the electronic
nameplate is read and all data transferred if the drive controller is connected online. This specifically includes job data,
current controller values, motor parameters, data on motor temperature sensors, brakes, the commutation offset and the
measured electromotive force. These can be manually optimized later and resaved in the drive controller.

Every time a drive controller is restarted, it checks whether the projected motor, the brake (if applicable), the motor
temperature sensor or commutation have been changed. If so, the changed data is read out. The optimizations saved in the
drive controller are maintained whenever possible.

The automatic read-out of the electronic nameplate is activated at the factory (B04 Electronic nameplate = 64: Active).

6.9 Lag monitoring

In Drive Based Center Winder type applications, you can monitor the lag of the axis with active position control in order to
detect increasing position deviations at an early stage. Monitoring the lag allows you to react quickly before material
damage can occur, e.g. in the event of stiffness or a mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2,,, of the control is
determined and compared with the maximum permissible lag (actual position: I80; set position: 196; permissible lag: 121;
result: 1187). If the permitted lag is exceeded, event 54: Following error is triggered with the corresponding protection level
(protection level: U22).
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7 Appendix

1.1 Standard mapping of Drive Based Center Winder

Information

For fieldbus communication via PROFINET, the processing of process data in some controllers is WORD-oriented (16 bits). In
Drive Based applications, the standard mapping is pre-assigned appropriately. If changes are made to the standard
mapping, take the parameter data type that you are adding to or removing from the mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can cause problems in the data structures of the
controller. If necessary, use parameter A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.
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711 SCB, S16: Drive Based Center Winder receive process data

The following table shows the standard mapping for the receive process data in the Drive Based Center Winder application.
For fieldbus communication via PROFINET, the process data mapping for axis A is done via parameter A90 and for axis B via
A91. For fieldbus communication via EtherCAT, the process data mapping for axis A is done via parameter A225 and for
axis B via A226. If necessary, the standard mapping can be customized.

BYTE Device control byte 1.A180
1 BYTE Control byte command 1.J37
2-3 WORD Control word application 1.1210
4 INT8 Command 1.J40
5 INT8 Motion-ID 1.J41
6-9 INT32 Position 1142
10-13 REAL32 Velocity 1 1.J43
14-17 REAL32 Velocity Override 1.J56
18-21 REAL32 Torque/Force reference 1.G469
22-23 WORD Control word center winder 1.L150
24-27 REAL32 Diameter sensor actual value 1.L25
28 -31 REAL32 Set material velocity 1.L405
32-35 REAL32 Actual material velocity 1.L450
36-39 REAL32 Set material tensile force 1.L496

Tab. 13: SC6, SI6: receive process data (standard mapping); first part, axis A

BYTE Device control byte 2.A180
1 BYTE Control byte command 2137
2-3 WORD Control word application 2.1210
4 INT8 Command 2.J40
5 INT8 Motion-ID 2.J41
6-9 INT32 Position 2142
10-13 REAL32 Velocity 1 2.J43
14-17 REAL32 Velocity Override 2.J56
18-21 REAL32 Torque/Force reference 2.G469
22-23 WORD Control word center winder 2.L150
24 -27 REAL32 Diameter sensor actual value 2.1L25
28-31 REAL32 Set material velocity 2.L405
32-35 REAL32 Actual material velocity 2.L450
36-39 REAL32 Set material tensile force 2.L496

Tab. 14: SC6, SI6: receive process data (standard mapping); second part, axis B
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11.2

SCB, S16: Drive Based Center Winder transmit process data

The following table shows the standard mapping for the transmit process data in the Drive Based Center Winder

application. For fieldbus communication via PROFINET, the process data mapping for axis A is done via parameter A94 and

for axis B via A95. For fieldbus communication via EtherCAT, the process data mapping for axis A is done via parameter

A233 and for axis B via A234. If necessary, the standard mapping can be customized.

8-11
12-15
16-19
20-21
22

23
24-25
26-29

BYTE
BYTE
WORD
BYTE
BYTE
WORD
INT32
REAL32
REAL32
WORD
INT8
INT8
WORD
REAL32

Status byte device

Status byte device

Status word 2

Status byte application
Status byte command
Status word application
Current position

Actual speed

Actual torque/force
Status word user-defined
Operating condition
Device control state
Status word center winder

Diameter filtered

1.E200(0]
1.E200[1]
1.E201
1.1212
1.139
1.1200
1.180
1.188
1.E90
1.A67
1.E80
1.E48
1.L155
1.129

Tab. 15: SC6, SI6: transmit process data (standard mapping); first part, axis A

8-11
12-15
16-19
20-21
22

23

24 -25
26-29

BYTE
BYTE
WORD
BYTE
BYTE
WORD
INT32
REAL32
REAL32
WORD
INT8
INT8
WORD
REAL32

Status byte device

Status byte device

Status word 2

Status byte application
Status byte command
Status word application
Current position

Actual speed

Actual torque/force
Status word user-defined
Operating condition
Device control state
Status word center winder

Diameter filtered

2.E200([0]
2.E200[1]
2.E201
2.1212
2.J39
2.1200
2.180
2.188
2.E90
2.A67
2.E80
2.E48
2.L155
2.L29

Tab. 16: SC6, SI6: transmit process data (standard mapping); second part, axis B
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7.2 Further information

The documentation listed below provides you with further relevant information on the 6th STOBER drive controller

generation. The current status of the documentation can be found in our download center at:

http://www.stoeber.de/en/downloads/.

Enter the ID of the documentation in the search field.

T e e TR

SC6 drive controller

Multi-axis drive system with SI6
and PS6

PROFINET communication — SC6,
Sl6

EtherCAT communication — SC6,
Sl

SR6 safety technology — STO via
terminals

SUG6 safety technology — STO and
SS1 via PROFIsafe

SY6 safety technology — STO and
SS1 via FSoE

Motion commands

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

Technical data, installation, commissioning,
diagnostics, detailed information

Technical data, installation, commissioning,
diagnostics, detailed information

Technical data, installation, commissioning,
diagnostics, detailed information

Control and status information, denials and
limitations, motion

442790

442728

443039

443025

442741

443258

442744

443349
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7.3

Formula symbols

Symbol Explanation

-n

z 2 2

2
MRdyn
MRstat

1.4

N Force

Nm Torque

Nm Torque at the gearbox input
Nm Torque at the gearbox output

Nm/1000 rpm Dynamic frictional torque of the axis

Nm Static frictional torque of the axis
rpm Speed

rpm Speed at gearbox input

rpm Speed at the gearbox output

Abbreviations

Al

ALT

CAN

CB

CiA

CNC

DI
EtherCAT
IGB

LS

LSB

M

M/F
MEnc
PEnc
PROFINET
RS

S

PLC

ZP

Analog Input

Alternative

Controller Area Network
Controller Based

CAN in Automation
Computerized Numerical Control
Digital Input

Ethernet for Control Automation Technology
Integrated Bus

Limit Switch

Least Significant Bit

Motor

Torque or force

Motor Encoder

Position Encoder

Process Field Network

Reference Switch

Switch

Programmable Logic Controller

Zero Pulse
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8 Contact

8.1 Consultation, service and address

We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:

http://www.stoeber.de/en/support

If you need our system support:
Phone +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Tel. +49 7231 582-3000

Our address:

STOBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12

75177 Pforzheim, Germany

8.2 Your opinion is important to us

We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise

productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our

documentation.

If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:

documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team
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8.3 Close to customers around the world

We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at

+43 7613 7600-0
sales@stoeber.at

STOBER FRANCE
www.stober.fr
+33 47898 91 80
sales@stober.fr

STOBER ITALY
www.stober.it
+39 02 93909570
sales@stober.it

STOBER KOREA
www.stober.kr
+82 10 5681 6298
sales@stober.kr

STOBER SWITZERLAND
www.stoeber.ch

+41 56 496 96 50
sales@stoeber.ch

STOBER TURKEY
www.stober.com
+90 216 510 2290

sales-turkey@stober.com

STOBER USA
www.stober.com
+1 606 759 5090
sales@stober.com

STOBER CHINA
www.stoeber.cn
+86 512 5320 8850
sales@stoeber.cn

STOBER Germany
www.stoeber.de
+49 7231 582-0
sales@stoeber.de

STOBER JAPAN
www.stober.co.jp
+81-3-5875-7583
sales@stober.co.jp

STOBER SWEDEN
www.stober.com

+46 702 394 675
neil.arstad@stoeber.de

STOBER TAIWAN
www.stober.tw
+886 4 2358 6089
sales@stober.tw

STOBER UK
www.stober.co.uk
+44 1543 458 858
sales@stober.co.uk
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Actual material tensile force

Actual tensile force with which the material is wound onto or unwound from a winder case in the winding process.

Actual material velocity

Actual velocity at which the material is wound onto or unwound from a winder case in the winding process.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Center winder

System that makes it possible to wind or unwind materials and in which the winder is driven by a shaft located in the

center of the winder.

Control cascade

Complete model of the control structure with the position controller, velocity controller and current controller

components.

Electronic nameplate

The synchronous servo motors are generally equipped with absolute encoders that provide special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and
electronic values of a motor. When you operate a drive controller with a synchronous servo motor and an absolute
encoder, the electronic nameplate is read and all motor data transferred if the drive controller is connected online. The

drive controller automatically determines the associated limit values and control parameters from this data.

Frictional torque

Torque that arises if friction forces act on a rotating body and restrict its rotation.

it model

Computational model for thermal monitoring.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

Mass moment of inertia

Indicates the resistance of a rigid body to a change in its rotational movement about a given axis (torque divided by

angular acceleration).
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Material tensile force

Tensile force with which the material is wound onto or unwound from a winder case in the winding process.

Material velocity

Velocity at which the material is wound onto or unwound from a winder case in the winding process.

PID controller

Universal controller type with a P-, I- and D-share. These three adjustment parameters make the controller flexible and
ensure exact and highly dynamic control. However, by implication, it also necessitates a wide variety of variants. It is
that much more important to ensure careful construction that is well-coordinated to the system. The application areas
for this controller type are control circuits with systems of the second order and higher, which must be stabilized

quickly and do not allow for any permanent control deviation.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

Set material tensile force

Target tensile force with which the material is to be wound onto or unwound from a winder case in the winding

process.

Set material velocity

Target velocity at which the material is to be wound onto or unwound from a winder case in the winding process.

Winder

A system that allows winding or unwinding of materials.

Winder case

Case that serves as a carrier for the material in the winding process and onto which material is wound or from which

material is unwound.

Winding

Unit consisting of a winder case and the material on it.

Winding diameter

Diameter of a winding.

Winding method

Method with which a material is wound onto or unwound from a winder case.
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